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1 Introduction

1.1 Product Overview

The GAUSS Mathematical and Statistical System (GAUSS)™ is a complete analysis
environment suitable for performing quick calculations, complex analysis of millions of
data points, or anything in between. Whether you are new to computerized analysis or a
seasoned programmer, the GAUSS family of products combine to offer you an easy to
learn environment that is powerful and versatile enough for virtually any numerical task.

Since its introduction in 1984, GAUSS has been the standard for serious number crunch-
ing and complex modeling of large-scale data. Worldwide acceptance and use in gov-
ernment, industry, and the academic community is a firm testament to its power and
versatility.

The GAUSS System can be described several ways: It is an exceptionally efficient num-
ber cruncher, a comprehensive programming language, and an interactive analysis envir-
onment. GAUSS may be the only numerical tool you will ever need.

1.2 Documentation Conventions

The following table describes how text formatting is used to identify GAUSS pro-
gramming elements:

Text Style Use Example

regular text narrative "... text formatting is

1-1
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used ..."
bold text emphasis "...not supported
under UNIX."
italics variables "..If vnamesisa
string or has fewer
elements than x has
columns, it will be ..."
monospace code example if scalerr (cm);
cm = inv (x);
endif;
monospace filename, path, etc. "...1s located in the
examples
subdirectory..."
monospace reference to a GAUSS "...as explained under
bold command or other plotScatter..."
programming element
within a narrative
paragraph
Bold Text reference to section of the "...see Operator

manual

Precedence, Section
10.7 ..."
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2 Getting Started

2.1 Installation Under Linux

1.

el S

Make a directory to install GAUSS in.

NOTE: If you choose to install GAUSS in a directory which does not have write
permissions for normal user accounts such as /opt or /usr/local, then you must
choose the Advanced Installation and Multi-User Installation options during
installation.

cd to that directory.

Gunzip the . gz file.

Untar the . tar file.

Run the executable script ginstall.

The script will give you the option of a default or advanced install. The default
option will install everything under the current directory.

The advanced installation allows you to choose a single-user or multi-user install-
ation and also allows you to place the shared libraries that GAUSS depends on in
another location. If you choose a multi-user installation, the binaries and most of

2-1
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the rest of the installation will reside in the current directory. Each time a new
user (a user that has never started GAUSS on this machine ) starts GAUSS on
this machine, GAUSS will create a local working directory for that user under the
user's home directory. This local working directory will contain the files and
folders that which may be customized by the user. This allows the admin to install
GAUSS in a location without universal write privileges. No files will be placed
under the home directory of any user who does not start GAUSS.

. Put the installation directory in the executable path.

. Install the license. To receive a license and license installation instructions, click

here and include the hostid information of your machine. The hostid number of
your machine is usually generated automatically during installation and stored in
the main GAUSS directory in a file called myhostid. txt.

For last-minute information, sese README.term.

2.2 Installation Under Windows

Following are the minimum recommended machine requirements and information on
how to install GAUSS under Windows.

2.2.1 Machine Requirements

o Operating System and Memory (RAM) requirements: Aptech strongly
recommends Windows 7 for greatest performance and reliability.

o Windows Vista 32-bit, 512 MB minimum, 2 GB recommended.
o Windows Vista 64-bit, 1 GB minimum, 2 GB or more recommended.

o« Windows 7 32-bit, 1 GB minimum, 2 GB or more recommended.

2-2
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o Windows 7 64-bit, 2 GB minimum, 4 GB or more recommended.
o Windows 8 32-bit, 1 GB minimum, 2 GB or more recommended.
o Windows 8 64-bit, 2 GB minimum, 4 GB or more recommended.

o Minimum of 200 MB free hard disk space, more may be needed depending on the
size of matrices and the complexity of the program.

e Minimum of 128 MB of RAM for video is required to run 3-D graphics. A
dedicated graphics card is not required.

o Monthly defragmenting is recommended for traditional hard drives. Solid-state
drives should not be defragmented.

2.2.2 Installation from Download

For information on downloading and download instructions, click here

2.2.3 Installation from CD

Insert the GAUSS compact disc into the CD-ROM drive, and setup should start auto-
matically. If setup does not start automatically, browse to the CD-ROM drive, and
double-click on the *.msi file to launch the installer.

You can use this procedure for the initial installation of GAUSS, and for additions or
modifications to GAUSS components.

Obtaining a license

To receive a license and license installation instructions, click here and include the
hostid information of your machine. The hostid number of your machine is usually gen-
erated automatically during installation and stored in the main GAUSS directory in a file
called myhostid. txt.

2-3

paueis bunien


http://www.aptech.com/contact-us/
http://www.aptech.com/support/license/




3 Introduction to the GAUSS Graphical
User Interface

3.1 Page Organization Concept

GAUSS graphical user interface is organized into six separate "pages," each designed to
facilitate the performance of one of the common tasks performed in GAUSS:

Command Page For executing interactive commands.

Source Page For editing program files.

Data Page For examining and editing GAUSS matrices and
other data.

Debug Page For interactively debugging your programs.

Graphics Page For viewing and interacting with graphs.

Help Page For accessing the GAUSS help system.

Pages are separate, customizable, main windows with their own set of widgets. Each
page is shown as a tab on the left-hand side of the main application, allowing you to
instantly access a window custom-configured for the task you wish to perform.
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Figure 3.1: GAUSS page tabs along the left side of the application

Pages may be undocked from the main application and redocked by toggling the Dock
button on the right side of the status bar. Navigation between an undocked page and the
main application may be accomplished with ALT+TAB and ALT+SHIFT+TAB. To nav-
igate between pages, use CTRL+TAB to cycle forward and CTRL+SHIFT+TAB to
cycle backward.

Each page has its own toolbars and menus, which perform desired functions and facil-
itate intuitive navigation through the GUI. For example, clicking the " New" toolbar but-
ton from any page in the GUI will bring the Source Page to the top of the window stack
with a new file open and ready for editing.
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3.2 Command Page

The Command Page is designed for entering interactive commands and viewing results.
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Figure 3.2: Command Page
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3.2.1 Command Page Menus

File Menu

New

Open File

Open Project
Folder

Open Graph

Print
Recent Files

Exit

Edit Menu

Undo
Redo
Cut

Copy

Paste

Creates a new, untitled file in a programming editor
on the Source Page.

Opens an existing file in a programming editor on the
Source Page.

Adds a folder and its contents to the GAUSS project
window on the Source Page.

Opens a previously created GAUSS graph (.plot
file).

Prints selected text.
Contains a dropdown list of recently edited files.

Exits a GAUSS session.

Restores your last unsaved change.

Re-inserts changes removed with undo.

Removes selected text and copies it to the clipboard.
Copies selected text to the clipboard.

Pastes the clipboard contents at the cursor position.




Introduction to the GAUSS GUI

Search

Advanced Search

Tools Menu

Preferences

Install Application

Change Font

Clear Action List

Change Working
Directory

Clear Working
Directory History

Recent Working
Directories

View Menu

Opens a search pane for the Program Input/Output
window.

Opens the Source Browser.

Allows you to configure the GAUSS user
environment.

Opens an installation wizard to install a GAUSS
application package.

Allows you to specify a new font. Aptech
recommends using a monospaced font such as
Courier.

Clears the recent files from the action list menus.

Allows you to browse for a new working directory.

Deletes the contents of your recent working directory
history.

Contains a dropdown list of your most recent
working directories.

The View menu lets you toggle on or off the windows on the current page.
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Help Menu
Goto Help Takes you to the Help Page.
About GAUSS Provides information regarding your version of

GAUSS.

3.2.2 Command Page Toolbar

2w = % 0[]

Figure 3.3: Command Page Toolbar

Introduction to the
GAUSS GUI

New Opens a new, untitled document in a programming
editor on the Source Page and brings you to the
Source Page.

Open Opens an existing file for editing.

Open Folder Adds a folder and its contents to the GAUSS project
window on the Source Page.

Cut Removes selected text and places it on the clipboard.

Copy Copies selected text to the clipboard.

Paste Copies the clipboard contents to the cursor position.

Print Prints selected text.

Run Runs the file at the top of the Action List.
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Debug Debugs the file at the top of the Action List.
Edit Opens the file at the top of the Action List.
Stop Program Stops a running GAUSS program.

3.2.3 Working Directory Toolbar

[F:‘lgausslS v][ ]

Figure 3.4: Working Directory Toolbar

The Working Directory Toolbar contains a dropdown list that shows your current work-
ing directory and a history of recent directories. The Change Working Directory button
allows you to browse for and select a new working directory.

3.2.4 Command History Toolbar
Search
Run Previous
e o] [@ 8

Paste Search
Mext

Figure 3.5: Command History Toolbar
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Run

Paste

Search Previous

Search Next

Executes the highlighted command from the
command history.

Pastes the highlighted command to the Program
Input/Output Window for further editing.

Searches the Command Output Window for previous
executions of a command and its output.

Searches the Command Output Window for the next
execution of a command and its output.

Introduction to the
GAUSS GUI

Run
Debug
Edit

Stop

3.2.5 Action List Toolbar

RLIm E(Iﬂt
O-®-U4-
| |
Debug Stop
Figure 3.6: Action List Toolbar

Executes a file from the Action List.
Debugs a file from the Action List.
Edits a file from the Action List.

Stops a program that is currently running or being
debugged.
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The Action List is a dropdown list of the files you have most recently performed an
action on. Clicking on the Run, Debug, or Edit button will perform the specified action
on the file at the top of the Action List. Placing your mouse over the button produces a
tooltip with the name of that file. To perform an action on a different file in the Action
List, click on the downward-pointing triangle immediately to the right of the desired but-
ton.

All of the buttons share the same Action List. You may add a file to the Action List by
running it from the command line. Or while editing a file, you can either select Current
File from the dropdown menu next to the Run or Debug button or Add to List from the
Edit dropdown menu.

3.2.6 Layout and Usage

The Command Page contains three main widgets: the Program Input/Output Window, the
Command History Window, and the Error Output Window.
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Figure 3.7: Command Page Widgets

3.2.7 Command History Window

The Command History Window contains a list of recently-executed commands organ-
ized by date or by GAUSS session. To re-run a command, double-click on it or select
the command and then press the Enter key.

Context Menu
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| . Togglt Wiew Mode

Figure 3.8: Command History

Right-click in the Command History Window to bring up the context menu with the fol-
lowing options:

Copy Copies the highlighted entry to the clipboard.

Delete Deletes the highlighted entry.

Clear Window Deletes all Command History entries.

Send to File Creates a new source file containing the highlighted
commands.

Toggle View Mode Toggles between date mode and session mode.
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3.2.8 Command Line History and Command Line Editing

When you run a command at the GAUSS prompt, it is added to your command line his-
tory. The last 1,000 commands executed at the GAUSS command line are stored. The
following keystrokes are supported for movement and editing at the command line and
for retrieving the command line history:

Left Arrow Moves cursor left one character.
Right Arrow Moves cursor right one character.
HOME

Moves cursor to beginning of line.

END Moves cursor to end of line.

CTRL+Left Arrow Moves cursor left one word.

CTRL+Right Arrow Moves cursor right one word.

Up Arrow Search up through command history.
Down Arrow Search down through command history.

NOTE: Use CTRL+PAGE-UP or CTRL+PAGE-DOWN to scroll through your program
output in the program input/output window.

3.2.9 Error Output Window

The Error Output Window shows errors messages from program runs or interactive com-
mands and may be viewed from any page by clicking the Error Output button on the right
side of the status bar. However, it will automatically open when an error occurs and will
close and empty its contents on the next program run or interactive command.
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The line number shown next to the error message is a clickable link (indicated by blue
text), which will take you to the file and line containing the error.

Erroer Dustput F x

O G0121 : Malrix nat positive definite [ grculang, ine 32)
Figure 3.9: Error Output Window

3.3 Source Page

The Source Page is designed for creating and editing programs and procedures.

3.3.1 Source Page Menus

Section 3.2 ) and the Debug Menu, the Source Page contains the following additional
menu options.

File Menu
Close Closes the selected file.
Close All Closes all open files.
Save Saves the active file.
Save As Saves the active file with a different file or path

name.

3-13
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Window Menu

Split File Bufter
Horizontally

Split File Buffer
Vertically

Remove Buffer
Split

Split Tab Stack
Horizontally

Split Tab Stack
Vertically

Remove Tab Split
Go Back

Go Forward

Previous Open
Document

Next Open
Document

Horizontally splits the active file into two views.

Vertically splits the active file into two views.

Removes a buffer split in the active file.

Tiles any open programming editors horizontally.

Tiles any open programming editors vertically.

Removes any editor window tiling.

Takes you to your last cursor position, which could
be in a different file.

After using Go Back, takes you to the next cursor
position, which could be in a different file.

Cycles backwards through the list of open tabs.

Cycles forward through the list of open tabs.
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3.3.2 Layout and Usage

The Source Page contains seven separate widgets: the Programming Editor, the Error
Output Window, the Program Input/Output Window, the Projects List, the Bookmarks
List, the Library Tool, and the Source Browser.
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Figure 3.10: Source Page

Programming Editor

Individual programming editors are opened in the editor docking area. The editor docking
area allows tabbing of multiple open files, with the option to tile editors with a horizontal
or vertical split. Select Window->Split Horizontally or Window->Split Vertically to
tile open editor windows.
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library tamt;

sregreasion on data gensrated by AUTOREG.3IM

struct automtControl arc;
aTEuct AautomtOut AES;
arc = mputomtControlCrasts)

lagvags = 0;
prdeyr = 341

struct D8 4d0;

di = pashaps(d0,2,1);
di[1] .dname = "antoragmt";

dO[1] . vnam==
d0[2] . vRames

masm

RN 5| =2

putput file = autoregmt.out resst;]
aro = autoresgmt (arc,dl,lagvars, ordsc];

cutput off;

Figure 3.11: Programming Editor

Programming editor features:

L.

Syntax highlighting:The GAUSS programming editor will provide syntax high-
lighting for GAUSS, C/C++, Java, Fortran, R and many other languages.

2. Autocompletion: Autocompletion is available in the GAUSS programming editor

for GAUSS functions and for structure members of any structure in an active

GAUSS library.
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s

eqln

eqsolve

egsolvemt
egsolvemtControlCreate
eqsolvemtOutCreate
egsolveset

e

Figure 3.12: Autocomplete

Using autocomplete: if the characters you enter match items in the autocomplete
list, a dropdown box will appear containing those functions. To navigate the drop-
down list, press the down arrow or continue typing until only one selection
remains. Once the desired command is highlighted, press the ENTER key to
insert the remainder of the word.

The editor will provide autocomplete for the members of any structures that are in
a GAUSS library if: the library is loaded, the file contains a statement to load the
library, or the structure definition is in the current file.

. Function Call Tooltips:After a GAUSS command and an opening parenthesis
has been entered, a tooltip will appear with the argument list for the function.
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Figure 3.13: Tooltips

4. Function Browser:Dropdown list lists all procedures defined in your file and
lists their arguments. Select a procedure from the list to navigate to its definition.

| File Edit Debug Tools View Window Help

UadoB QX UELHN ©O©-®-4-C

Introduction to the
GAUSS GUI

e EK_E'NWL:Z ] | zandre:
E intgrat2 (£xl,gl)
o _intgrat2 (fx|, glintrec)
intgrat3 (f,glhi)
g _intgrat3 (f x|, gl hl,intrec)
I

Figure 3.14: Function Browser

5. Code folding: At the start of code blocks (e.g., procedure definitions, do and for
loops, and 1 f statements), the left margin of the programming editor will contain
a +. Clicking the + will hide the block of code from view and place a horizontal
line across the editor indicating folded code and changing the + to a -. Clicking on
the - will reveal the hidden code.
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160 Hproc (1) = matpmixth);

161 local pm, ixth;

162 ixth = rows (xth);

163 pm = zeros(ns,.ns);

le4 if ipm == 1; // for ns = |2
165 [H if izz — 1;

168 [ else;

165 pm[l,1] = xth([1,1];
170 pml[2,2] = =xth[2,1];
171 endif;

Figure 3.15: Code folding of 'if' block

6. Autoindenting: The GAUSS programming editor provides automatic code indent-
ing and deindenting. Autoindenting not only simplifies the process of writing code
but also encourages the creation of readable code.

7. Variable highlighting:Click on a variable name and all instances of that variable
will be highlighted.

160 Hproc (1) = matpm(xth);

161
162
163

le4
165

le6
167

8. Find usages: Right click on a variable or procedure and select 'Find Usages' from

local pm, ixth;
ixth = Iows{ﬂth};

IND SSNVD
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pm = zeros(ns,ns);
if ipm == 1; // for n=s =2 this option has para
if izz == 1;

pm[1,1] = kth[1,1]72/(1 +xth[1,1]"2);
pm[2,2] = kth([2,1]12/(1 + xth[2,1]"2)

Figure 3.16: Variable highlighting

the context menu to create an organized clickable list of all usages in your file.
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9. Bookmarks:Bookmarks allow quick navigation to often visited lines of code. To
insert a bookmark, hold down the SHIFT key and left click in the left margin of

10.
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161 Lingo i+
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Figure 3.17: Find usages

the file on the line where you would like to set the bookmark.

If a file contains more than one bookmark, you may use F2 to navigate to the next
bookmark in the file. To navigate between bookmarks in multiple files, use the
bookmark window. The bookmark window contains a list of all of your book-

marks.

Double-click on a listed bookmark and GAUSS will bring you to the file and line
of your bookmark regardless of whether the file is already open for editing or not.

Source code formatting: The GAUSS editor will correctly format a source file
with incorrect formatting. This is available from the context menu or with the hot
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key CTRL+1I.

Programming Editor Hot Keys

CTRL+A

CTRL+C

CTRL+D

CTRL+F

CTRL+G

CTRL+I

CTRL+L

CTRL+N

CTRL+0O

CTRL+P

CTRL+/

CTRL+R

CTRL+S

CTRL+T

CTRL+V

CTRL+W

Select AllL

Copy.

Debug current file.

Find and replace.

Go to line.

Formats the current file.
Delete line.

Open new file.

Open existing file.

Print file.

Used for block commenting.
Run current file.

Save current file.

Switches current line with the line above.
Paste.

Closes the current file.
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CTRL+2Z Undo.

CTRL+Y Redo.

CTRL+~ Cycles through open editor windows.
CTRL+F1 Go to definition of function under cursor.
Fl

Go to Help Page for function under cursor.

SHIFT+EL Open inline help for function under cursor.

ALT+Left-Arrow Go to previous cursor position, which may be in a
previous file

ALT+Right-Arrow After ALT+Left-Arrow, go to next cursor position.

3.3.3 Find and Replace

From the Edit Menu, selecting Find and Replace or pressing CTRL+F will bring up the
find and replace widget at the bottom of your open programming editor. If a word is high-
lighted when you access find and replace, it will automatically be present in the find box
when the find and replace widget is opened. Press the ENTER key or > to search for-
ward. Press the < button to search backwards. To close the find and replace widget,
press ESC or click the button on the left.
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Figure 3.18: Find and Replace

The Replace Box has three buttons: > means replace the highlighted expression and
search forwards, < means replace the highlighted expression and search backwards and
replace means replace the highlighted text and do not change the cursor position.

Regular Expressions

Find and Replace in GAUSS supports regular expression searching. Regular expression
searching gives users tremendous power allowing quick and precise search and replace
throughout an entire file. For example, let us start with a file containing the following

commands:
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= 100;

= 50;

rndn (r,c) ;

= rndu(r,c);
x.*rndn (r, c) ;

N K X QB
I

Regular expressions allow you to perform very specific find and replace commands. Sup-
pose that we want to find all usages of rndu and rndn and replace them with
rndKMu.

I'l' e

-

endasad 3453I4E;
% w {100, 5 =

t £ila™;

ary"

x| Fnd: znd [£] (3] ) whoie word 7] Match case [ [Repen]
Replece: rndmu < ][] [ dureciace | [y Puclace A1

Figure 3.19: Find and Replace Regular Expression

To open Find and Replace, we enter CTRL+F in out open text editor. In the Find and
Replace widget, select the check box next to Regex to enable regular expression search-
ing. One of the most simple regular expression options is to add a '.". The '.' means any
character. So, if we search for "rnd." that will find any string that contains rnd
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followed by any character, such as rnda, rndb, rndc, rndn, rndu, etc. Now enter
"rndKMu" in the replace box and click Replace All. Now all instances of rndu and
rndn should be replaced with rndKMu.

3.3.4 Changing Editor Properties

Programming editor preferences can be accessed by selecting: Tools->Preferences
from the menu bar. From the Preferences window, select Source from the tree on the
left. Here you can customize the programming editor's behavior.

Graphics Keywards: - PreProcessor: -

# Comments: - Selecton Bockground: |

o) Source

Command Tab Size: 4 Autocompleion Source
7 Auto Indent: || " GALISS Library

- Ling Numbers: /] Current Document

Source Current Line Highlight: J{ 8 Al |
LUise UTF8 (W

: Encoding o
Symbol
frme Colors

Advanced

Figure 3.20: Editor Preferences

The editor preferences has three main sections:

General Settings

The general settings are located on the top left.
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Colors

This section is located along the bottom half of the preferences dialog window. Click
one of the color buttons to change an element in the color scheme used in the editor.

Autocomplete Settings

On the top right of the Source Preferences, under the heading "Autocompletion Source" ,
are the controls for autocompletion settings. This allows you to choose the contents of
your dropdown autocomplete suggestions. The options are:

GAUSS Library Provides autocomplete suggestions for
GAUSS intrinsic functions.

Current Document Provides autocomplete suggestions for all variables,
procedures, GAUSS functions and keywords that
are used in the file.

All Provides autocomplete suggestions for both above.
None Provides autocomplete suggestions only when
CTRLA+SPACE are pressed.

3.3.5 Error Output Window
The Error Output Window can be accessed by toggling the Error Output button on the

right side of the status bar. For details regarding the features and usage of the Error Out-
put Window, see Section 3.2.9 .

Errosr Ourtput ®x

@ GO121 : Matrix not positive definite [ grculre, ine 3]

Figure 3.21: Error Output Window
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3.3.6 The Source Browser: Advanced Search and Replace

The Source Browser is a powerful search and replace tool that makes it much easier to
work with your code--especially when completing larger projects. You may open the
Source Browser by selecting View->Source Browser from the Source Page or entering

the hot-key SHIFT+CTRL+F.

o e
Fie Edt Debug Tooh View Window Halp
U 8 AL T A D-9-4-0 Comn -]
Booimariy L | reres— fop— = | =]
255 d0[1] . vnames &
35§ andif;
,E, 257 o = erece{d] imdvarnms = "pone™)
35§ if rowsidlp = 1;
255 ® d2[2] ;davaMatrin;
H 260E if d0(Z] . mamen §== =
,i 26l indvarfims "H "+ fooev (sogail; 1, cols (k) ;aee. vpad*
1 162 alam;
283 | ipdvarams Al [2] . vRasES
264 E andid;
i 265 alse;
264 srroclog "ERROR independent varisbles not fcand®;
I 267 | and:
——— Libwarp Todd CE 260 wndid;
E prera— o ::g | retp_auteregae jare, " 40 [1] .daraMarris, ¥, deprarmm, indvarn
.‘ Pathe 271 endif;
prnekyg F ara -
— 273  acdp:
= #1 ame i
oty s s |
[ ] paraghicn gy —s 8 x
bty & T
_ SEwch | Advanced | Raeplace ¥ Crigeusslaisreiasutoregat.are (18]
i R re— - ¥ Civgsusaldisrcigdsols. erc (23]
@ Fropeis & M| Felieme e = ¥ Crigeusaldiarciolant.are (18] [ |
Drectory: Cyigmats 34 - 4 [ Cigeunaldiarcitecent erc (8]
1 T Calry - H rrr.hr:.ndv.nr:.v:dv.v:r:.atr._‘,
Cear 20 Search
i o 2ld; { depverns,dvind I = ftndfcesfnil
¥ 216! { depvarna,dvind } = {ndicenfn(:

T P " phigrenaven Tosared B2 reabihes o DB L

1f sealsrcidanusrnal or seslsce -

s 285, cat 1 [wre- g [

C L L
Pl i N

Figure 3.22: Source Browser

The Source Browser is made up of two main sections. The control tabs are on the left
and on the results display on the right.

You can enter your search query in the Search tab, which allows you to specify a par-
ticular file pattern, filename, or directory to search. The button with three dots [...] to the
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right of the directory dropdown menu is a browse button that will open a dialog window
allowing you to browse for the desired directory.

| Search | Advanced | Replace |

Find:  rndu -
Pattern:  =.src -
Direchory:  C:jgauss 14/src * |

Claar ] Stop [ Search

Figure 3.23: Search and Replace

The Advanced tab allows you to refine your search criteria. Checking the References
check box will limit your search to only locations where a variable is referenced. Altern-
atively, checking the Assignments box would limit your search to only those places
where the variable was assigned to. For example, if you were searching for the variable
'nobs’', this is an assignment:

nobs = 300;

whereas this 1s a reference:

myVar = nobs - 1;

Advanced Replace

Match Case: |:| Qcourrences
Whole Word: [
RegEx: [ [7] References

Max File Size (MB): 500

Search Subdirs: [7] Assignments

Ignore Binaries:

M=

Figure 3.24: Advanced Search and Replace
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You may also select to limit your search to whole words, match case or use regular
expressions. This tab also allows you to control whether your search extends to sub-
directories and if you would like to exclude files larger than a certain size. It is recom-
mended that you always select Ignore Binaries.

Executing a search

Once you have a search string in the Find box and have your desired parameters set,
press the 'search’ button to execute your search. In the results display window, you will
see a list of files that contain matches to your search. To the left of each file in the list
you will see a check box which can be used to include or exclude the matches in a file
from any Replace actions. To the right of the file name you will see a number in par-
entheses which indicates how many matches were found in the file.

| Search | Advanced | Replace |

383: mobs = tobs;

¥ |C:ygausslasreladfat.sre (4) &
Find: mobe - ¥ Ci\gaussld\sre\dataxchn.sre (27)
Pattern:  ®.arc - ¥ Ci\gaussld\sre)\pdadetat.sre (T)
Drectory:  Cjpauss 4 - '| 4 [ C:\gauszld\sre\gdaolzs.sre (36)
r ) [# 253: =se,nobs,mobs be,b,ve, stderr,t,
Clear | Stop Search J :
L
b

315: elear mn,nc,m,i,nobs;

ERt LR |

[l 336+ anhe = Askes{ce fe &)

Figure 3.25: Executing a search

Expand the node of a file to examine its list of matches, or right-click and select 'Expand
All' from the context menu. Once you expand the node for a file, you will see the line
number of the match followed by a colon and then the line of code with the match high-
lighted in yellow. Double-click on a line to edit that file.

Executing a replace

After you have completed your search and unchecked any matches that you do not want
replaced, click the Replace tab. Enter your replacement term and press the Replace but-
ton. GAUSS will warn you that any changes in unsaved files cannot be undone. If you
are certain of your replacement, click OK.
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If you are making a change across a large number of files, particularly if you are not
using a version control system like Subversion or Git, it is a good idea to select the
'Backup Original' check box. With this selected, before GAUSS makes the replace-
ments to your file it will save a copy of the original with a . bak extension. For example
if your original file was myfile.gss, the backup file will be called
myfile.gss.bak.

If you select the 'Overwrite Backup' checkbox, the next time that you make a change to
this file, the file myfile.gss.bak will be overwritten. If you do NOT check the
'Overwrite Backup' check box, GAUSS will make incremented backup files:
myfile.gss.bak(l),myfile.gss.bak(2), etc.

3.3.7 Project Organizer: Keeping track of files with the Pro-
ject Window

The Project Window displays the contents of any folder you choose as well as its sub-
folders. To add a folder to the Project Window, either right-click in the Project Window
and select “Add Folder” from the bottom of the context menu or click the “Open Folder”
toolbar button.
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o

<> GAUSS

File Edit Debug Tools View Window Help
UallRB QAU LES
o PrujectFniﬁ]penPrn_iectFu:qu:Ierl g x
L] —_—
:

O

ok

o

5

@

|

Figure 3.26: Open Project Folder

By default, all files in the folder will be shown. If you would like the Project Window to
display only certain file types, you can enable file filtering by right-clicking in the Pro-
ject Window and selecting “Filter GAUSS Files.”
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' 4 7 Logit 10 x
E’E < glogit -
< glogit Open Enter
i < logitl Run Ctrl+Enter E
< logit2 Add te Run List
- )
E & MiReg Delete File... Del
2 - = Probit
:‘ & plbams Rename...
| ReadMe Synchronize with Editor
- Reference : i
8 Filter GALISS files %
£ [ & src !
i [
5 Add Folder
L 22 st
- Type to locate (Ctrl+k) ii S8
o
= | Project Folders Library Tool F mn
@

Figure 3.27: Filter File List

With “Filter GAUSS Files” enabled, the Project Window will display only files that
match the list of file extensions found under "Tools->Preferences->Source->Project
View Filter: Files to Show". This is a comma-separated list of file extensions, which

may be modified by the user.

Interacting with files in “"Project Window"”

Double-click on a file name to open it or right click to bring up a context menu that will
allow you to perform other actions, such as: "open", "run", "delete" and "rename".
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Searching for text through all files in a directory

Right-clicking on a directory in the Project Window and selecting “Find in folder” will
open up the “Source Browser” an advanced find-and-replace window. The "Directory"
field will be pre-populated with the directory you selected.

P

< GAUSS
File Edit Debug Toocls View Window Help

DaaB D XTJ0H

= Project Folders 5 X f

[1n}
=

E | |4 bam 2

| API 3

1ok ARMA 4

40 MCM 5

o > @ AREr Refresh &

3 @ HBM| Find in Folder |\ 7

= » & HERe g

LinRe Synchronize with Editor g

4 @ Logit Filter GAUSS files 10

‘ 2 ©| glo 11

< gl Add Folder
(5 gie . 12

Figure 3.28: "Find in Folder"

By default the “File Pattern” field will contain “*.*”. This means GAUSS will search in
all files in the specified directory that have any type of file extension. If you would like
to include in your search files that do not have file extensions, change the “File Pattern”
field to just “*”. Finally, add the text you wish to search for to the “Find” field and click
the "search" button.
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Source Browser

Search | Advanced | Replace |

Find: v_hat] -
File Pattern: == -
Directory:  C:fgauss/bam/MCMC - E

Figure 3.29: "Find in Folder" opens the Source Browser

Searching for a file by name

When working with large numbers of files over multiple directories, it can be difficult to
search through a growing list of tabs. The GAUSS Project View Window allows you to
almost instantly locate any file that is in one of the folders you have open or in your
GAUSS SRC_PATH. To search for a file, click in the text edit box at the bottom of the
Project Window, or use the Ctrl+K shortcut. As you begin to enter the filename, an auto-
complete list of matching files will appear. The up and down arrow keys will navigate
the autocomplete list. Press ENTER to open the file.
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< logit2.gss |_
=1 5 MixReg
=
a = & Probit -
’, < plbam.src
| ReadMetdt
n - References
= [ @ src
el
o]
k|

itl.gss [ bam\MCh i‘l.L::- it logitl.
< logit2.gss [FAbam\MCMI Logitilogit?.gss]
< legit.gss [ChgausslSexamplesilogit.gss]

@ Help

Figure 3.30: Find File

3.4 Data Page

The Data Page provides a tree view of all of the active symbols in your GAUSS work-
space organized by data type. Double-click one of your active symbols to open the data
in a Symbol Editor. Symbol Editors provide a spreadsheet like view of your data.
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o

<> GAUSS
File Edit Tools Wiew Window Help
a @ 4 ‘ 7 ﬂ T & [C:‘gauss
T | Symbols F X | median_wage [£) unemployment _rate || |
E | a Symbols
.E 4 Matrices [EH Format "” Global | Matrix
of median_wage[42:1] 2
" unemployment_frequency (scalar)
unemployment_rate[120: ] 1 629
o unemployment_start (scalar)
é wage_frequency (scalar) 2 B2
wage_start (scalar)
- 4 Arrays 3 63
gdp_change[2x250x4] 4 646
2 Sparse Matrices
= Strings 5 F47
il 4 String Arrays
war_names[5:1] 6 647
=] 4 Structures
& > myPlot[1x1] 7 631
= Control Vars
‘ & 658

3.4.1 Changing values

Figure 3.31: Symbol Editor

You may change the value of a single cell in a symbol editor by double-clicking in the
cell and entering the new value. Note that hitting enter or clicking outside the cell will
save your change. To revert an in-process change before it is saved, hit the escape key.
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x B

][ Fomat ~v|| Giobal | Mati
1 2

1 Lo z

2 0176216 0.0934052 (

Figure 3.32: Change Cell Value

3.4.2 Changing formatting

Change the formatting of the numbers in a symbol editor by clicking the “Format” button
and then, selecting a format type and then selecting the precision.

x B

[5]| [ Format_ x| Global | Matrix 1000x3
Decimal—'*| 1 3

. Scientific ¥ 2 b 0120729
Compact  * 3

2 String 1 0.268911

3 1.4979 1 5 0.659809

4 0.251613 1 6 2.74864

5 -0.616605 2 ; -1.4865

& -1.35364 - 9 -1.22833

Figure 3.33: Change Number Format
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The “Compact” format will choose either “Scientific” or “Decimal”, whichever creates
the most compact representation of the data.

If none of the cells are selected, the formatting will be applied to all cells. If you select
a cell, column or row before you choose the format style, it will only be applied to the
selected data. This allows you to apply different formatting to each of your variables if
you desire.

3.4.3 Navigating multi-dimensional arrays

At the top-right of an array symbol editor you will find a listing of the all the dimensions
in the array. All but the final two dimensions will be list widgets. Click them to select a
particular dimension to view.
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-

< x

Global Array 10x2x900:8 (< | [fammdxz— ~Ixs00xs
r 11
1

2 3 4 6

J’:wu

1 -0.34865 0.00156922 -1.27358 0.519971 0 0.34371

2 0314291 0.0139654 1.42009 0655494 03 E'? 0.600317
3 0422197 1.04702 1.71279 -0.153142 15 g -0.551053
4 0352756 -0.127849 0614395 -0.1679.22 -1 .JT%E_ 1.08661

5 157653 0274578 -0.0630501 =0.153067 1.38366 -0.806903
6 0134207 0988677 -111432 -1.51236 -0.599871 -1.16807
7 -0821198 15383 -0.382252 0881358 0.0295897 0.313959
8 138587 -1.21669 0.368875 0.03103 -2.02884 -1.04582
9  -140723 -0.589459 0.0185736 -0.742282 0.79673 0.0905395
10 -0.16516 -0.211846 00527875 -0.016469 0128704 -0.3713
11 09659706 -1.3853 0.0513205 =0.665386 -0.B44687 022259

IND SSNVO
sy 0] UondnNpoJIU|

=

Figure 3.34: Select Dimension to View

On the left of the array dimensions is a button with a leftward facing chevron. Clicking
this button will navigate towards the start of the array. The corresponding button on the
right of the array dimensions will navigate towards the end of the array.
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3.4.4 Viewing structure members

Double-click on a structure member in the Active Symbol Tree to open it in a symbol
editor.

3.4.5 Creating a floating watch window

Y ou may undock the symbol editors from the “Data Page” and place them anywhere on
your screen by clicking the “Toggle dock™ button which looks like an arrow to the left of
the “Format” button. They will be updated every time that a program ends or a com-
mand-line statement is executed, which can make this a good way to keep track of your
data.

3.5 Debug Page

3.5.1 Menus and Toolbars

Clear Step Ste
Go Breakpoint Into Out
I | | |
aw M M =
© a2 &N
Toggle ExarLine STLp R;ILiD
Breakpoint Breakpoint Owver Cursar

Figure 3.35: Debug Toolbar
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Go

Toggle Breakpoint
Clear Breakpoints
Examine Variable

Step Into

Step Over

Step Out

Run to Cursor

Stop

Runs the program to the next breakpoint.
Sets/Clears a breakpoint at the cursor.
Clears all breakpoints in a file.

Opens a watch variable in a symbol editor.

Runs the next executable line of code in the
application and steps into procedures.

Runs the next executable line of code, but does not
step into procedures.

Runs the remainder of the current procedure and
stops at the next line in the calling procedure.

Runs the program until it reaches the cursor position.

Terminates a debugging session.

Components and Usage

The Debug Page is composed of five main widgets:

Breakpoint List
Call Stack Window

Local Variable
Window

Variable Dump
Window

Watch Window

An interactive list of all breakpoints.

An interactive display of the chain of procedure calls.
An interactive display of all variables that are in
scope.

Displays the full contents of a variable.

An interactive display of user specified variables.
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The Debug Window indicates which line it is on by the >>> located in the left margin.
This is also the location where breakpoints are added. To add a breakpoint, click in the
left margin of the Debug Window on the line you wish to add the breakpoint. Clicking an
active breakpoint will remove it.
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Figure 3.36: Debug Window

Starting and Stopping the Debugger

You can start debugging of a file you are in by pressing CTRL+D. Click the Debug but-
ton to debug the file in the top of the Action List. Placing your mouse over the Debug but-
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ton will reveal a tooltip with the name of this file, or click the downward pointing tri-
angle next to the debug button and select a file from the list.

e B Gom vew  Hep
; 0 .
Ladad XG0 @94 -0 Cos ]

[rrs & Chgrasiasmplesiiegiesie
Arehived CAgaunrimamplerfisuncel g
Lasi Month Cgeusieamples s, ¢
Lest Week Chgauisimamplesiohie
Today

Cgeunrimampler plotaddd .0
Cgauashepegles Culane
£ gauns plotcatinke
Chgeunsiplotounel &
Chgausiphsteunel ¢

| saren | covmand

Figure 3.37: Debug Button

When the debugger is started, it will highlight the first line of code to be run. Any break-
points are shown in the left margin of the window. You can stop debugging at any time
by clicking the Stop button on the debug toolbar.

3.5.2 Using Breakpoints

Breakpoints stop code execution where you have inserted them. Breakpoints are nor-
mally set prior to running the debugger, but can also be set or cleared during debugging
by clicking the Set/Clear Breakpoint option on the Debug menu.

Setting and Clearing Breakpoints

To set breakpoints in any part of the file not currently being executed, just click in the
left margin of the line on which you would like the breakpoint. Alternatively, you can
highlight a line then click Toggle Breakpoint.
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kil "‘"Hj
30F { b,f0,gxd, ret |} = QNewton(&lpr,bl);

- 31

Z % cov = invpd(hessp(&lpr,.b));

&

’ 34 print "coefficients atandard errars"™;
35 print;
36 print b~sgrt(diag(cov));

8

£ 37 F

g 38 output off;

W 38
I

Figure 3.38: Setting Breakpoints

To clear a breakpoint in the file, click on the breakpoint you would like to remove or
click a line of code that has a breakpoint set and then click Set/Clear Breakpoint. You
can clear all breakpoints from the active file by clicking Clear All Breakpoints.

3.5.3 Stepping Through a Program

GAUSS's debugger includes the ability to step into, step out of, and step over code dur-
ing debugging.

Use Step Into to execute the line of code currently highlighted by the debugger.

<> GAUSS14
File Edit Debug Tools View Help

YR ERRE
Program Input/Output [-Step In (F8)

| A - A AT NG

Figure 3.39: Step In (F8)

sand

3-44



Introduction to the GAUSS GUI

Use Step Out to execute to the end of the current function without pause and return to
the calling function.

< GAUSS14
File Edit nehug ]‘ools View Help

@ﬂl Eﬂﬂﬁ"If_x

Prugan Input/Output Step Out (F10) i

Flgure 3.40: Step Out (F10)

and

Use Step Over to execute the line of code currently highlighted by the debugger without
entering the functions that are called.

< GAUSS14
File Edit Debug Toocls View Help

©L G RMAR
Program Input/Output m

I ar A [l A AT AT

Figure 3.41: Step Over (F9)

1and

Use Stop to stop the debugger.

File Edit Debug Toolks View Help

f-. “. ._#ﬁ’ki. i3 ;i *| | &Y 1@}. Ebﬂ.ﬂ'ﬂ!

'E Frogram Input,Cutput [ “Stop Frogram ‘
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Figure 3.42: Stop

3.5.4 Viewing Variables

GAUSS allows you several ways to view the values of variables during debugging.

Hover Tool-tip View

Once the debugger is started, hovering your mouse over a variable name will open tool-
tip with a preview of the values in the variable.

3 x = rndn{1886,5);

4 T Eu,‘d.r]mﬁ 1% &

5 x - {100x%)

B c 1 2 3 4

7 4di -1.033586 1.503042  -1.27638T 0.149639  -0.97407%

a 2 -0 831634 -1.124874 -1.1269B5 -0.761334 -2.261459
3 -0.381396 1.707824  -1.313411 -0.714726 -0.4T4EET

4 49, -0.548527 -1.750340 0.163373 0.800256  -0.646054

o L] =0. 768667 0.358478 =-0.406751 1.083171 0. 189284

i ge -0.924957 0.207550  0.91404%  1.627728  0.E9E2ES

2 g’ -1.023687 -0.478185 0.445034  1.934220 -0.238448 |,
g 0.363982  -0.035412 0.230467 -1.729343 0.044203

13 B -0.935146 ~-1.7084B1 0.4E1953  -2.054935 0.593717 :

14 10 0.773233  1.230422  -0.TA31TH  1.286337  -2.180730

15 11 -0.795048 0.743320 -D.BEEZ49 -0.345332 -0.435414
1z 0.565898  =0.161283 =0.BSEEET 0.717435  0.896405
13 -0. 355115 O.38E485 032142 -1.840031 -0.11712%
14 0.513047  1.343035 0.790227  -0.300854 0.718954
15 =0.603921 =1.561721 =0.654570 0.455347 =0.E40511
1 0.070840  0.4596%6  -0.B59737 -1.053572 -0.380217
17 -0.319235 0.262853 0.200525  1.069472 -0.B72234
1E 0.912913  0.B507Ed  -D.3092B54 0.640273  -1.046571
19 1.190174  =1.778012 =0.4B9145 0.157945  1.336438
20 =0,307075 ~-1.017031 ~-1.065312 O0.631352 =0, 062475

Figure 3.43: Hover Tool-tip

These tooltip views are only intended to give a quick view of the data, so they may not
show all data held by the variable. If you need to view more data, you may either click
on the variable name in the file and type CTRL+E, click the Examine Variable toolbar
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button and enter the variable name, or double-click the variable in the Local/Watch Win-
dow to view the variable in a floating symbol editor.
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Figure 3.44: Watch Window

Setting a Watch Variable

The Watch Window list is directly below the the Local Variable list. It displays the
same information about the variables in its list as does the Local Variable list. By
default this list starts empty. You may add variables to the list by either right-clicking
over the name of a variable in the Local Variable list and selecting "Add to watch" from
the context menu, or by right-clicking directly in the Watch Window and selecting "Add

n

new .

The debugger searches for a watch variable using the following order:
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1. A local variable within a currently active procedure.

2. A global variable.

3.6 Help Page

The Help Page gives you access to the entire GAUSS help system in HTML format.
The table of contents tree is on the left. Click the + symbol to expand a particular sec-
tion of the contents and double-click on the title to view the page. As on the other pages,
the Program Input/Output Window and the Error Window are available via toggle but-
tons on the status bar. It can be helpful to enter an interactive command and/or view
error output while simultaneously viewing the relevant documentation.
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Figure 3.45: Help Page
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Hot Keys

Fl

CTRL+F1

SHIFT+F1

Opens the Command Reference section for the
highlighted command.

Opens a programming editor with the function
definition of a highlighted procedure.

Opens a floating Help Window for the highlighted
command.

3-49

IND SSNVD
aYy1 0} UONONPOJIU|






4.1 Action Hot Keys

F2
F3
F4
F5

F6

E7

F8

F9

F10
CTRL+D

CTRL+R

4 Hot Keys and Shortcuts

Navigates to the next bookmark in the Active File.
Find again.

Runs highlighted text.

Run file at top of Action List.

Debug file at top of Action List. Inside a debug
session, F6 will cause the debugger to run to the
next breakpoint, or the end of the file if no
breakpoints are encountered.

Edit file at top of Action List.

Step in (during a debug session).
Step over (during a debug session).
Step out (during a debug session).
Debug the Active File.

Run the Active File.
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4.2 Navigation Hot Keys

GAUSS automatically navigates between pages when you perform certain actions. For
example, if you are editing a file in the Source Page and type CTRL+D to debug that
file, GAUSS will automatically take you to the Debug Page.

However, there are also several hot keys that allow you to navigate quickly and easily
between pages without performing any actions:

CTRL+1 Brings up the Command Page.

CTRL+2 Brings up the Source Page.

CTRL+3 Brings up the Data Page.

CTRL+4 Brings up the Debug Page.

CTRLA+5 Brings up the Help Page.

CTRL+TAB Brings up the next page. For example, CTRL+TAB

from the Command Page will bring up the Source
Page. CTRL+TAB from the Help Page will wrap
and bring up the Command Page.

ALT+TIAB Cycles between any pages that are undocked as well
as other open programs.

WINDOW+TAB Windows only: Cycles between any pages that are
undocked as well as other open programs.

Mouse Scroll When floating over any set of tabs, the mouse scroll

Wheel . . .
wheel will cycle through the open tabs. This will
work for programming editor tabs, symbol editor
tabs, and the main page tabs on the left of the main
application.




Hot Keys and Shortcuts

4.3 Focus Program OutputonI/O

Under the Tools->Preferences->Command is a check box entitled Focus Program
Output on I/0. Selecting this option will open up a Program Output Window if any pro-
gram output is printed or if any input is requested by the GAUSS commands key,
keyw, or cons.

4.4 F1 Help

If your cursor is on the name of a GAUSS command in an editor, you can press F1 and
it will take you to the Command Reference listing for that command. Inside the Help sys-
tem, highlight command names by double-clicking on them to enable F'1 help navigation.

Shift+F1 Inline Help

Typing SHIFT+F1 when your cursor is on a GAUSS command will open an inline help
window that floats above your editor window.

43
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Figure 4.1: Inline help window opened with SHIFT+F1

4.5 CTRL+F1 Source Browsing

If your cursor is on the name of a procedure or global variable that resides in an active
GAUSS Library (. 1cg file), typing CTRL+F1 will open the source file in a Pro-
gramming Editor.

To learn more about creating a User Library for your procedures, see LIBRARIES,
CHAPTER 19 .
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5 Using the GAUSS Debugger

The GAUSS debugger is a powerful tool to speed up and simplify your program devel-
opment. Debugging takes place on the Debug Page, which is a full-featured dashboard
providing you a wealth of information about the status of your variables and your pro-
gram every step of the way.
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Figure 5.1: The debug button automatically opens the
Debug Page

5.1 Starting the Debugger
@ - %w d/ - '\"5:*“","'

Figure 5.2: Debug Button
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You may start a debug session by selecting the Action List Debug button, by entering
CTRL+D from the file that you would like to debug, or by entering debug rilename
from the command line. GAUSS will bring the Debug Page to the front, and the debug
session will begin with the first line of code highlighted, waiting to be run.
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Figure 5.3: Debug Window

From here you can step through your program line-by-line, or run to a line of interest. To
tell the debugger to run to a particular line, you must first set a breakpoint. Setting a
breakpoint on a line in your program tells the debugger to pause when it gets to that line.
You may set a breakpoint in any source file by simply clicking in the margin to the left
of the line numbers. You will see a red dot appear in the margin, and a new entry will be
added to the breakpoint window, which can be viewed on both the Source and Debug
Pages. New breakpoints can be added before or during a debug session.
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The Debug Page toolbar gives you the controls you need to navigate during debugging.
Hover over any of the buttons to get a tooltip with a description of the button's function

and its corresponding hot key.

Clear Step Step
Breakpoint Into Out

| |
Tﬁz}? ¥ ETa M =l

Toggle Examine Step Runto

Breakpoint Breakpoint Ower Cursar

Debug Run
Debug Stop
Toggle Breakpoint
Clear Breakpoints

Examine Variable

Step in

Step over

Step out

Run to cursor

Figure 5.4: Debug Toolbar

Runs to the next breakpoint.

Stops the debug session.

Toggles a breakpoint on the current line.
Removes all breakpoints from all files.

Opens a user-specified variable in a floating Symbol
Editor window.

Steps to the next line. If the next line is a procedure, it
will step inside this procedure.

Steps to the next line without stepping into other
procedures.

Runs through the end of the current procedure and
stops in the calling file.

Runs to the location of your cursor as if it were a
breakpoint.
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5.2 Examining Variables

When the debugger is paused at a line in your program, you may view any of the vari-
ables in your GAUSS workspace. GAUSS offers several options for this. The first is
through the Local Variable window. This window contains an alphabetical list of every
variable that is currently in scope. It also lists the first value of each variable, its type
(matrix, string, structure, etc.) and dimensions. The contents of this window are imme-
diately updated each time you step to a new line of your program.

Local/Watch Varables @
Mame . Type Value i
Lgradproc[l:] Matrix 0.000000
Lmaxiters[1x1] M atrin 100000,000000
Lprintiters[1:1] Matrix 0.000000
Lrelgradtol[1:1] Matrix 0.000010 L
Lrteps[lsd] Matrix 0,010000 r
11 ] Matrix 0.000000
frnct[1:] M atrix &40.000000
maxtry[lxl] Matrin 100,000000
np(l:] M atrix 4,000000 |
sp2[1x2] M atrix 0.000000
wy[2x2] M atrix 1.000000 -
Mame : Type Value
w[dxd ] M atrix 5.000000
z[ 2] M atrix 0.000000

Figure 5.5: Local Variable Window

Double-clicking on a variable in the Local Variable window opens that variable in a
floating symbol editor. This symbol editor window looks much like a spreadsheet and
will display the entire contents of the variable.
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Located just below the Local Variable window is the Watch window. The Watch win-
dow looks and acts much the same as the Local Variable window, but it holds only vari-
ables that you specifically add to it. This allows you to place variables of interest in a
smaller list that is easier to scan. You can add a variable to the Watch window by either
right-clicking on a variable in the Locals list and selecting "Add to watchlist", by right-
clicking in the Watch window and selecting "Add new", or by highlighting a variable in
the file and then dragging and dropping it into the watch window.

Dec Scd Hex Chr

1

-1.03359 1.50304
-1.27639 0149639
-0.974079 -0.831634
-1.12487 -112608
-0.761334 -2.2615

-0.381396 1.70732

-1.31341 -0.714726

-0.474867 -0.848527
-1.75034 0163373

10 0800256 -0.646054

Figure 5.6: Symbol Editor Window

You may see a tooltip preview of any variable in your file by floating your cursor over
the variable name. Placing your cursor on a variable and pressing CTRL-E will open
that variable in a floating symbol editor.
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5.3 The Call Stack Window

The Call Stack window is like a map into your program. The top entry in the Call Stack
window is always your current location. It lists the name of the procedure you are in, the
arguments that this procedure takes, the name of the file it is in, and the line number you
are on. The next item in the list displays the same information for the location from
which your current procedure was called. The item after that displays the location from
which that procedure was called and so on.

Call Stack

(1} = lpr(b]) [circular.e: 47]

(5} = _bfgsifnct, «0, Lmaxiters, Lrelgradtol, Lgradproc, Lprintiters, Lrteps) [gqnewton.src: 178]
4] = QMewton(fnct, x0) [gnewton.src: 98]

(0} = main() [circulare: 30]

Figure 5.7: Call Stack Window

This list is interactive. Single-clicking on any of the items in the Call Stack window will
bring you to that particular line and file. For example, if you would like to examine the
line from which your current procedure was called, click on the second item in the call
stack list. Not only will this open that line and file in your Debug window, but it will
also update the Local Variable window to display all the variables that exist at that loc-
ation, as well as their current values. To return to your current location, click the top line
in the Call Stack window.

5.4 Ending Your Debug Session

If you would like to terminate a debug session before the debugger has run through the
entire program, click the Debug Stop button, located at the top left of the Debug Page.
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File Edit Debug Tooks View Help
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Program InputQutput Stop Program |
|

Figure 5.8: Debug stop button
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6.1 Overview

6 GAUSS Graphics

The plotting functionality available in GAUSS is designed to provide intuitive methods
for visualizing data using a variety of plot types. The main plot drawing functions are:

plotArea
plotBar

plotBox

plotContour
plotHist
plotHistF

plotHistP

plotLoglLog

plotLogX

plotLogY

Creates a cumulative area plot.
Creates a bar plot.

Creates a box plot using the box graph percentile
method.

Creates a contour plot.
Calculates and creates a frequency histogram plot.
Creates a histogram plot from a vector of frequencies.

Calculates and creates a percentage frequency
histogram plot.

Creates a 2-dimensional line plot with logarithmic
scaling of the both the x and y axes.

Creates a 2-dimensional line plot with logarithmic
scaling of the x-axis.

Creates a 2-dimensional line plot with logarithmic
scaling of the y-axis.
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plotPolar
plotScatter
plotSurface
pPlotTs

plotXY

6.2 Basic Plotting

Creates a polar plot.

Creates a 2-dimensional scatter plot.
Creates a 3-dimensional surface plot.
Creates a graph of time series data.

Creates a 2-dimensional line plot.

The simplest way to plot data in GAUSS is to use default values for the plot settings,
such as line color, line size, legend text, etc. These settings may be changed by the user
from the main menu bar: Tools-> Preferences-> Graphics. To create a plot using
default plot settings, simply call one of the plotting functions with your data as inputs:

//Create a sequential column vector from
//=-5 to 5 with 101 steps

x = seqa (-5, 0.1,

101);

//Set y to the normal probability density function

y = pdfn (x);

//Plot the data
plotXY (x, v);
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Figure 6.1: One-Curve Plot

6.2.1 Plotting multiple curves

Each column of the input matrices is treated as a separate curve or line on the graph.
Below is an example that uses the variables created from the example above and adds

an additional line:

x = seqa (-5, 0.1, 101);
yl = pdfn (x);

//Set y2 to the Cauchy probability density function
y2 = pdfCauchy (x, 1, 1);

6-3
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//Plot the data using the ~ operator to horizontally

//concatenate yl and y2
//Note that yl and y2 will be plotted against the same

//x values

PlotXY (x, yl~y2);
< Al ==
fibe  ddst Tooh Vew Help
AWFHs/-mem 0-%-4-Q man
g P ] -
5]

H

Gt

.40

+ B

.50

.0l
“6.0

=40

oo
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6.0

GAUSS Graphics

A v
Cy
b

Figure 6.2: Two-Curve Plot

6.3 Plot Customization

GAUSS offers two ways to customize your graphs. The first is through the graphics pref-
erences dialog window. The second method for plot customization is using a plotCon-

trol structure.
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6.3.1 Using the Graphics Preferences Settings Window

Main Graph Settings

The default settings for graphics can be opened by selecting Tools->Preferences from
the main application menu bar . Then select Graphics from the list on the left of the pref-

erences window.

< Preferences L)
o Graphics
Command Gereral
Mew grapha: @ Reuse same tsh Ot v b
= ’mmm = : hew | | Ooe
Source Graph Setings
- Genersl Series 1
E Title
[ata Legend
does Style Legend Tithe:  Sries 1
oty Toxt Line: Cobor
._ Serigt : -
P Series Line Wit (p=): 2
e Series 3 e =
Senesd : - 4
— Series § Spmbal; | Elone =]
Geaghics Symbal Widh (p; 10
s [
Fa
advanced Pl Coacky: |
[ pactary et | S -~

Figure 6.3: The Graph Settings Tab

Selecting a graph type

Each type of graph in GAUSS has its own settings. Click on the graph type list widget to
expand the list of graph types. Click on one of the listed graph types to view its settings.
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Graphics
iG]
Command General

Mew graphs: @ Reuse same

=
Source
Scatter (Default)
Polar (Default)
Bar (Default)
D Surface (Default)
Box (Default)
Data Area (Default

Figure 6.4: The Group Tab

Once you have selected a graph type, browse through the settings by clicking on a an
individual graph component, such as the “Legend”, “Axis Style” or “Axis Text”. "Series
1", "Series 2", etc contain the preferences for the curves such as "line color", "line thick-

ness", "symbol type", etc.
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Figure 6.5: Scatter plot graph settings

After you have made your desired changes, Click the 'Apply' and 'OK"' buttons. GAUSS

will use these preferences for all future graphs that are made without passing in a

plotControl structure. As we will see in the next section, these settings will also be the
starting point when you create a plotControl structure. These settings may be changed at

any time.
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Contour/Surface Plot Z-Level Color Settings

£ Preferencer (00 )
Graphics
&
Command Gerardl
Mew graphs: @ Reuse same b Ot nitw
o Surfmce (Dedmit) = | Mew | Cone
Source Graph Setings
- General Colors
| Title
Cata Legend
woes Style
Aol Tead
1 Colors
Diekasg
Geaphici
Level Counk: 80 {Conbour Oniy)
s
Acheanoed
[ Fachory Defauns | ox ][ coreel 1! res

Surface/Contour Level Color Settings

If you select the 'Surface' graph type, you will see a 'Colors' option instead of 'Series 1,
Series 2..." as shown above. The "Colors" control allows you to add and subtract default
z-level colors and to also change their order.

Available Actions

Add a new color Click the add (+) button

Edit a color Double-click the color

Select a color Single-click the color

Delete a color Select a color and click the minus (-) button
Change color order Click-and-drag color to desired position, or select a

color and click the up or down button
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6.4 PlotControl Structures

The GAUSSplotControl structure provides a powerful and flexible method for pro-
grammatic control of your graphs in GAUSS. This structure is a convenient package that
stores all of the information about how you would like a specific graph to be displayed.
These structures may be saved to disk and reloaded during a future session or passed on
to colleagues. Using a plotControl structure requires just two easy steps:

1. Declare the structure.
2. Initialize the structure.

Once these steps are completed, you may change any of the plot settings in the structure.
Once the plotControl structure is set how you would like, you can pass it in as the first

argument to any of the GAUSS plot-creating functions. Below is an example that draws

a graph using a plotControl structure set to default values:

//Declare the structure
struct plotControl myPlot;

//Initialize the structure
myplot = plotGetDefaults ("xy") ;

//Create a column vector from -3 to 3 with a step size of 0.1
x = seqa (-3, 0.1, 60);
y = sin(x);

//Plot the data using the plotControl structure
plotXY (myPlot, x, y);

The available plotControl setting functions include:

plotGetDefaults Applies the user defined default settings
for a specified graph type to a
plotControl structure.

plotSetBar Sets the fill style and format of bars in a
histogram or bar graph.

6-9
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plotSetBkdColor

plotSetFill

plotSetGrid

plotSetLegend

plotSetLineColor
plotSetLineStyle

plotSetLineSymbol

plotSetLineThickness

plotSetNewWindow

plotSetTitle

plotSetWhichYAxis

plotSetXLabel

plotSetXRange

plotSetXTicCount

Sets background color of a graph.

Sets the fill style, opacity and color for
area and bar plots as well as histograms.

Controls the settings for the background
grid of a plot.

Adds a legend to a graph and optionally
applies settings.

Sets line colors for a graph.
Sets line styles for a graph.

Sets line symbols displayed on the plotted
points of a graph.

Sets line thickness for a graph.

Sets whether new graphs should be
drawn in the same window or in a newly
created window.

Controls the settings for the title for a
graph.

Controls whether a particular curve uses
the right or left Y -axis.

Controls the settings for the X-axis label
on a graph.

Controls the minimum and maximum
values of the X-axis.

Sets the number of major tics along the
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X-axis.

plotSetXTicInterval Controls the interval between X-axis tic
labels and optionally at which X-value to
place the first tic label.

plotSetXTicLabel Controls the formatting and angle of X-
axis tic labels for 2-D graphs.

plotSetYLabel Controls the settings for the Y-axis label
on a graph.

plotSetYRange Controls the minimum and maximum

values of the Y -axis.

plotSet¥TicCount Sets the number of major tics along the
Y -axis.

plotSetZLabel Controls the settings for the Z-axis label
on a graph.

Most of these functions begin with plotSet. This has two main advantages. First, you
may quickly and easily survey the plotSet options by typing plotSet in a GAUSS
editor and scrolling through the auto-complete list without needing to consult the doc-
umentation. Second, this convention makes your GAUSS code easy to read and under-
stand.

Example

//Declare plotControl structure
struct plotControl myPlot;

//Initialize the structure with the "bar" default values from
//the main application menu Tools->Preferences->Graphics

myPlot = plotGetDefaults ("bar") ;

//Create data to plot

6-11

solydesn sSSNVO



GAUSS Graphics

GAUSS User Guide

be
Yy

seqa(l, 1, 10);
abs (rndn( 10, 1 ));

//Change plot settings
//Turn off the grid
plotSetGrid (&myPlot, "off");

// Set x-axis label
plotSetXLabel (&myPlot, "Day of Project");

//Set the title, title font and font size
plotSetTitle (&myPlot, "Example Bar Plot", "arial", 18);

//Draw graph
plotBar (myPlot, x, Vy);
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u " 1 1 % 5 6 7 [ 9 19
$ Day of Project
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Figure 6.6: Example Bar Plot

6-12



GAUSS Graphics

Notice in the previous example that the first input to the plotSetTitle function is
&myP1ot and not just the variable name, my P1ot. This is because all of the plotCon-
trol setting functions take a structure pointer as the first input. The ampersand (&) in
front of the variable name makes the input argument a pointer to that structure.

Passing structure pointers as arguments is much faster and more efficient than passing
an entire structure. The rule for remembering when to use a plotControl structure
pointer instead of plotControl structure is simple. If the function you are calling sets a
value in the structure, you need to use a structure pointer. In all other cases, use the
structure.

Fortunately the function completion tooltip in the GAUSS editor will indicate which is
required, in case you forget this simple rule. For more information on structures and
structure pointers see STRUCTURES, CHAPTER 16 .

6.5 Adding Data to Existing Plots

Y ou may add additional data to 2-D plots. This functionality is accessed through the fol-
lowing:

plotAddArea Adds a cumulative area plot an existing 2-D
graph.

plotAddBar Adds a set of bars to an existing 2-D graph.

plotAddBox Adds a box plot to an existing 2-D graph.

plotAddHist Adds a histogram to an existing 2-D graph.

pPlotAddHistF Adds a frequency histogram to an existing 2-
D graph.

plotAddHistP Adds a percentage histogram to an existing
2-D graph.

plotAddPolar Adds a polar plot to an existing polar graph.
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plotAddScatter Adds a scatter plot to an existing 2-D graph.

plotAddTs Adds a time series plot to an existing time

series graph.

plotAddXy Adds an XY line to an existing 2-D graph.

Any 2-D plot type may be added to any other 2-D plot type, with the exception of con-
tour plots, polar plots and time series plots. You may add a polar plot to a previous polar
plot or a time series plot to a time series plot. Use the plotAdd functions only to add
data to an existing graph. Do not attempt to use them to create a new graph.

Example

//Create and plot multivariate random normal data
rndseed 19823434;

cov = {1 0.9, 0.9 1 };

mua = { 2, 2 };

y = rndMVn (300, mu, cov);

plotScatter(y[.,1]1, vI[.,2]1);

//Create line coordinates and add to scatter plot
x = { -0.3, 4.8 };

y2 = { 0, 4.3 };

plotAddXY (x, vy2);
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Figure 6.7: Example Adding Data to a Plot

6.5.1 Styling and the plotAdd functions

Plot-wide attributes

The plotAdd functions will not make any styling changes to the existing plot-wide
attributes, such as the title, axes labels, grid, etc. It will, however, increase the scale of
the view if needed to accommodate the new curve.

Curve level attributes

If the plotAdd call does not use a plotControl structure, attributes for the added
curves such as line or fill color, symbol style and the curve's legend text will be con-
trolled by the preferences settings. The new curve will be treated as an additional series
in sequence with any curves that already exist on the plot. For example if you draw a
scatter plot with one column of data and then add another column of data with plotAd-
dScatter and do not pass in a plotControl structure, the second set of scatter points
will use the scatter settings from "Tools->Preferences->Graphics->Scatter->Series 2".
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//Use scatter "Series 1" settings
plotScatter(x 1, x 2);

//Use scatter "Series 2" settings
plotAddScatter(x 3, x 4);

If you pass in a plotControl structure to the plotAdd call, GAUSS will apply the first
series curve settings in the plotControl structure to the first series of data that is added.
For example:

struct plotControl myPlot;
myPlot = plotGetDefaults ("scatter");

//Use the Series 1 line color settings
//set in 'myPlot' by 'plotGetDefaults'
plotScatter (myPlot, x 1, x 2);

plotSetLineColor (myPlot, "purple" $| "blue");

//Use the Series 1 line color settings
//in the plotControl structure, purple
//for x 3 vs x4, use blue for x 3 vs x 5
plotAddScatter (myPlot, x 3, x 4~x5);

The above code first creates a scatter plot of x 1 vs. x 2. It then changes the line
color settings inside the plotControl structure to purple for the first set of scatter points
and blue for the second set of scatter points. Finally, it adds the scatter series x 3 vs.
x4 which will be drawn in purple and x 3 vs. x 5 which will be drawn in blue.

6.6 Creating Subplots

GAUSS allows you to create two types of graphs within graphs. The first is called a sub-
plot. In GAUSS a subplot divides the canvas up into tiles of equal size and shape.
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This functionality is controlled with the plotLayout function. The plotLayout
function splits the canvas up into a specified number of rows and columns and also spe-
cifies into which cell to draw the next graph.

//Divide the canvas into 2 rows and 3 columns

and

//set the next drawn graph to be placed into the
//last position (which is the sixth cell);
//plotLayouts use row major ordering
plotLayout (2, 3, 6);

1123
41516

Figure 6.8: plotLayouts use row major ordering

After calling plotLayout, all future graphs will be placed in the cell location spe-
cified by the plotLayout call until plotLayout is called again with new para-
meters or a call to plotClearLayout is made. A call to plotClearLayout will
cause the next graph to be drawn to take up the entire canvas.

This next graph, after a call to plotClearLayout, will either draw over any existing
graphs or be drawn in a new window depending on your graphics preferences. This set-
ting can be controlled from the "New graphs" setting, located under Tools-> Prefer-
ences-> Graphics. It may also be set with the plotSetNewWindow function.
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Example

//Divide the canvas into 2 rows and 2 columns
and
//place each successive graph in the next
//available cell
for 1( 1, 4, 1);

plotLayout (2, 2, 1i);

//Plot a percentage histogram with 10*i bins
of

//random normal data

plotHistP (rndn(le5, 1 ), 10%*1i);
endfor;
//Clear the layout so future graphs are not
drawn in
//this layout

plotClearLayout () ;
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Figure 6.9: Example Subplot

6.6.1 Creating Mixed Layouts

In GAUSS, plotLayouts may not overlap. For this functionality use the plotCus-
tomLayout function. However, you may divide the canvas into sections of different
size as long as they do not overlap.

Example

//Divide the canvas into a 2x2 grid and fill in the first row
plotlLayout (2, 2, 1);

pPlotHistP (rndn (1e5,1), 20);

plotlLayout (2, 2, 2);

PlotHistP (rndn (1e5, 1), 40);

//Divide the canvas into a 2x1 grid and fill in the
//bottom half, leaving the top section alone
plotLayout (2, 1, 2);

pPlotHistP (rndu(le5, 1 ), 80);
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Figure 6.10: Example Mixed Layout

6.6.2 Creating Custom Regions

Custom regions in GAUSS are graphs inside of graphs. They may be placed in any loc-
ation on the canvas and may be any size. This functionality is controlled by the
plotCustomLayout function. It takes the location and size parameters for the cus-
tom region as a percentage of the entire canvas. As with plotLayout, these settings
will be applied to the next drawn graph.

//Draw a custom region that starts 25% of the
//distance from the left edge of the canvas, 10%
//from the bottom of the canvas with a width of 40%
//of the canvas and a height of 28% of the canvas
plotCustomLayout (0.25, 0.1, 0.4, 0.28);

Unlike with plotLayout, these custom regions will not delete any graphs below them
and can thus be used to place a small graph over a portion of a larger graph.
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Example

//Draw a full size graph
rndseed 908734;

y = rndn(le5, 1);
plotHistP(y, 30);

//Draw a custom region, close-up over the bottom left
// of the previously created graph
plotCustomLayout (0.1, 0.3, 0.2, 0.4);

//Set up plotControl struct with simple view
struct plotControl myPlot;

myPlot = plotGetDefaults ("box") ;
plotSetLegend (&myPlot, "off");

plotSetGrid (&myPlot, "off");
plotSetXAxisShow (&myPlot, O0);
plotSetYAxisShow (&myPlot, O0);

//Create plot in custom region defined above
plotBox (myPlot, 0, vy);

//Clear the layout, so future graphs will not be
//drawn in this custom region
plotClearLayout() ;
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Figure 6.11: Example Custom Layout

6.7 Time Series Plots in GAUSS

GAUSS provides the following functions to simplify the process of creating time series

graphics:
plotAddTs

plotTsS

plotSetXTicLabel

plotSetXTicInterval

Adds a time series curve to a previously draw
time series graph.

Creates a graph of time series data.

Controls the formatting and angle of X-axis tic
labels for 2-D time series graphs.

Controls the interval between X-axis tic labels
and also allows the user to specify the first tic to
be labeled for 2-D time series graphs.

To create a basic time series plot in GAUSS, you will use the plotTS function. In addi-
tion to the y data to plot, this function requires the following inputs:
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dstart Scalar, the starting date of the time series in DT
scalar format.

frequency Scalar, the frequency of the data per year. Valid
options include:

12 Monthly
4 Quarterly

1 Yearly data

Example

//Data to plot
y = rndu(24, 1);

//Start the series in January of 1987
dstart = 1987;

//Specify the data as monthly
freqg = 12;

//Plot the data
plotTS (dstart, freq, v);

The example program above will create a graph of monthly data from January of 1987
through December of 1988. It should look similar to the graph below:
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Figure 6.12: Close-up of monthly data plot
Understanding the dstart parameter

The dstart parameter is specified to be a scalar value in DT scalar format. In DT
scalar format the leading four digits are the year and the next two digits, if present, rep-
resent the month. If the month information is not present, as in the example above,
GAUSS will assume the first month of the year. This means that this:

2008

and this:

200801

will both be treated as specifying January of 2008.

To specify a starting quarter in DT scalar format, set the final digits of your dstart to
be the first month of the quarter. The following represent 2008 Q1, 2008 Q2, 2008 Q3
and 2008 Q4 respectively.

200801
200804
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200807
200810

6.7.1 Quarterly Example

Using what we have just learned, we will create a quarterly graph that starts at 2007 Q4
and runs for 16 quarters.

//Create 16 random data points
y = rndu(le, 1);

//Start the series in 2007 Q4
dstart = 200710;

//Specify the data as quarterly
freq = 4;

//Plot the data
plotTS (dstart, freq, Vv);

This should produce a graph that looks similar to this:

6-25

solydesn sSSNVO



GAUSS Graphics

GAUSS User Guide

-
=

‘ﬁ Debig
[}
(%]

Graphics
=
]

=
=

2007-04 2008-0Q2 2008-04

@ Help

Figure 6.13: Close-up of quarterly data plot

6.7.2 Controlling Tic Label Locations

The first tic label on the X-axis of the graph that we drew at the end of the last section
is located on the first data point, 2007 Q4. Let us suppose that we would prefer the graph
to have tic labels only on the first quarter of each year. We can accomplish this by using
the function plotSetXTicInterval.

plotSetXTicInterval has the following parameters:

interval the number of data points between each X-tic that
is labeled.
firstLabeled the value of the first data point to be labeled.

Since we are working with quarterly data and would like to place X-tic labels on each
year, we will set the interval parameter equal to four and we will set the
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firstLabeled to be the first full year in our series, 2008. This will change our pro-
gram to look like this:

//Declare and initialize plotControl structure
struct plotControl myPlot;
myPlot = plotGetDefaults (“xvy”) ;

//Create 16 example data points
y = exp(seqa (0, 0.2, 16)) + rndu(le6, 1);

//Start the series in 2007 Q4 and specify
//quarterly data

dstart = 200710;

freq = 4;

//Start x-tic labels at 2008 and label every 4th
//data point

interval = 4;

firstLabeled = 2008;

plotSetXTicInterval (&myPlot, interval, firstLabeled);

//Plot the data
plotTS (myPlot, dstart, freq, vy):

This code should create a graph with x-tic labels only on the first quarter of each year as
you see below:
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Figure 6.14: Quarterly data graph

We can see that the X-tics are in the correct location. However since we are only
labeling each year, we may not want Q1 printed next to the year on each of the X-tic
labels.

6.7.3 Tic Label Formatting

We can change the formatting of these labels and optionally the angle at which they are
printed with the function plotSetXTicLabel. This function has the following argu-
ments:

fmt string, specifying the format with which to format
the X-tic labels.

angle scalar, the angle at which to print the labels

The fmt input can take many forms, see dttostr and strtodt for all options, but for this
purpose we are only concerned with these three:
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YYYY print the four digit year.
Q0 print the quarter as Q1, Q2, Q3 or Q4.
MO print the month as a two digit number.

These format specifiers can be placed in any order. You may place any characters in
between them and they will be printed literally. For example if we start with 201204:

fmt = “YYYY-Q0Q”;
will tell GAUSS to print the date as:
2012-02
whereas:
fmt = “MO/YYYY”;
tells GAUSS to print the date as:
04/2012
Since we want to print only the four digit year on our x-tic labels, we will set:
fmt = “YYYY”;

Giving us the following program:

//Declare and initialize plotControl structure
struct plotControl myPlot;
myPlot = plotGetDefaults (“xvy”) ;

//Create 16 example data points
y = exp(seqa (0, 0.2, 16)) + rndu(le6, 1);

//Start the series in 2007 Q4 and specify
//quarterly data
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dstart = 200710;
freq = 4;

//Start x-tic labels at 2008 and label every 4th
//data point

interval = 4;

firstLabeled = 2008;

plotSetXTicInterval (&myPlot, interval, firstLabeled);

//Label X-tics with only the 4 digit year
plotSetXTicLabel (smyPlot, “YYYY”);

//Plot the data
plotTS (myPlot, dstart, freq, vy);

This final program should yield a graph that looks similar to:
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Figure 6.15: Quarterly data graph
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6.8 Interacting with Plots in GAUSS

Once a graph has been created, GAUSS provides interactive zooming, panning, and the
moving of legends and subplots as well as the ability to hide and restore individual
curves on the graph. Plot rotation is also available for 3-dimensional plots.

6.8.1 Interacting with 2-D Plots

To interact with plots in GAUSS, first select the "Zoom/Pan Plot" button from the tool-
bar. With this button selected, you will be able to perform actions on the view of a par-
ticular plot. Zooming is controlled by the mouse scroll wheel. Scroll the mouse wheel
forward to zoom in. Pan and scroll is accomplished by drag-and-drop with the mouse.
Note that upon zooming or panning, the axes will be automatically updated to reflect the

new view.

Zoom/Pan
Plot

Revise
Layout
Figure 6.16: Zoom/Pan Plot Toolbar

Hide/Restore Curves

Each legend item is also a button that hides and restores individual curves, bars, etc.
Click on a legend item to hide the corresponding curve. Notice that the axes will auto-
matically scale to the remaining curves. Click the legend item again to restore the curve

to the graph.
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Figure 6.17: The legend acts as a button to hide curves

Relocating Graphic Items

To relocate subplots or legends first select the "Revise Layout" button. Y ou may then
drag and drop the item to its desired location. If you would like the legend to maintain its
position relative to the graph when it is relocated, you can accomplish this by selecting

the legend, right-clicking and selecting "regroup" from the context menu.
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Figure 6.18: Drag and drop to relocate the legend

If you would like to change the z-order of an item in a layout, you may select it, right-
click to bring up the context menu and then choose, either "Send to Front" or "Send to
Back." Individual plots and their respective legends will both be affected.
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Figure 6.19: Bring textbox to top of z-order to cover arrow tail

6-34



GAUSS Graphics

6.8.2 3-D Plots

= =

Figure 6.20: Surface plot

Zoom

Zooming in and out on a 3-dimensional graph may be accomplished by use of the mouse
scroll wheel.

Rotate/Viewpoint Change

To rotate 3-dimensional plots and examine the graph from different viewpoints, right-
click and drag with the mouse (two-finger click and drag on Mac).

6.8.3 File Export

When exporting a graph interactively, the first step is to set the size of the entire graph
image, called the Canvas.
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Customizing the Canvas

To access the Canvas settings, from the Graphics Page toolbar select “View->Graphics
Settings”. This will display the settings for whichever graphics object has focus. This
could be the graph and its legend, an annotation object such as an arrow or textbox, or
the Canvas. To give focus to the Canvas, click between the edge of your graph and the
edge of the graphics tab.

@v" Ef M~

& || Median weekly earnings vs. unemployment rate

[ »

Median weekly ¢
800.0

m

750.0

T nEeE- V-Abae

Figure 6.21: Select Canvas

Once you have opened the Canvas settings, set “Fixed Size” to “true”. This will prevent
the Canvas, and your graph, from being resized if you manually resize your GAUSS win-
dow. With this box is checked, the Canvas size will be controlled only by the Canvas
Settings window.

Setting the size in terms of pixels

If you will be using the image in an electronic format, you will want to set the image
size in terms of pixels. The “Units” Canvas setting controls whether the canvas will be
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sized in terms of pixels or a unit of physical size. By default, “Units” will be set to
“pixels”.
Double-click the numbers in the “Width” and “Height” boxes to edit the numbers. If the

“Fixed Ratio” option is set to “true”, then when you change the “Width” or the
“Height”, the other dimension will be changed to keep the height-to-width ratio the

same.

Graph Settings g X
Field Value

4 (Canvas Size

Fixed Size ’true - ]
Units ’ pixels b ]
Width

Height 455.00

Fixed Ratic ’true - ]
DPI 95

4 (Canvas General

Background |:|

Figure 6.22: Control canvas size

Setting the size in terms of physical size (inches, millimeters)

If you are exporting an image for print, you may want to set the image size in terms of a
physical size. To accomplish this, you will need to set the “Units” to either “mil-
limeters” or “inches” and you will have to set “Width”, “Height”, and the “DPI” or dots
per inch. This will allow GAUSS to create an image with enough pixels for your image
to be printed at your desired size with the required dots per inch.
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Make any final adjustments

As you will see, when you change the Canvas dimensions in GAUSS, the graph image
will be adjusted to reflect those changes. This gives you a live preview of what your
exported image will look like. After you have changed the overall size of your Canvas,
you may want to make some adjustments to the size of fonts or lines on your graph to
make them proportional to the new size of the whole. Click on the graph to display the
Graph Settings in the Graphics Editor window, then make any necessary adjustments.

Exporting the file

Once you have the image as you would like it, select File->Export Graph from the main
application menu and then select a filename, image type, and folder in which to save
your file.

Copy and paste graphs into other programs

To copy and paste a graph from GAUSS to another program such as PowerPoint® or
Word®, right click on the graph inside of GAUSS and select “Copy to clipboard”. Next,
open the other program and “paste” the graph at an appropriate location into your file.

Note that when you copy an image to the clipboard, it becomes a raster image, which
means that resizing may decrease the image quality. Therefore, it is recommended that
you first appropriately size the image in GAUSS before copying the image to the clip-
board.

6.8.4 Saving Graphs

Graphs may be saved and then reloaded later. To save a graph, select the graph you
would like to save and then select File->Save Graph from the main menu. GAUSS
graphs are saved in a file with JSON format and a .plot extension.
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Figure 6.23: Save Graph menu

Graphs may also be saved programmatically with the plotSave function.

6.9 Adding Annotations Programmatically in GAUSS

In addition to adding annotations such as text boxes, arrows and lines interactively with

the Graphics Editor, you may also add annotations in your GAUSS program. This func-

tionality is provided through the following functions:

Adds arrows or lines to the last created graph.

plotAddArrow

Adds ellipses and rectangles to the last created

graph.

plotAddShape

GAUSS Graphics
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plotAddTextbox Adds a textbox to the last created graph.

Basic rules

1. As you can see from the function prefix, plotAdd, these functions are meant to add
to a graph that already exists. They will not create a new graph.

2. Added annotations will not expand the range of the X and Y axis so that they will fit
inside the visible axes. This allows you to place annotations outside the axes or
between different subplots.

6.9.1 Basic usage

Like the plotting functions, the graph annotation functions can be called without any styl-
ing options specified, or the user can pass in a control structure which will set the styling
for the annotation. Here is a basic example of adding a text box:

//Create and plot some data
x = seqa (0, 0.01, 628);

y = cos(x)~sin(x);
plotXY (x, y);

//Text to place in the text box
text string = "Sine is the derivative of cosine";

//Location of the top left corner of the text box
//will be the position (3,0.8) on the graph

x start = 3;

y start = 0.8;

//Add text box
plotAddTextbox (text string, x start, y start);
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The positioning of the annotation, setby x start and y start above, are in terms
of the points on the graph to which the annotation is added.

Here is another basic example of adding an arrow:

//Arrow start and end locations

x start = 3;
y _start = 0.8;
x end = 1.07;
y end = 0.5;

//Specify the head size
//at the end of the arrow
//in terms of points

head size 10;

//Add the arrow to the last created graph
plotAddArrow (x start, y start, x end, y end, head size);

6.9.2 Creating multiple annotations with vector inputs

You may create multiple annotations with one function call by passing vector inputs to
plotAddArrow, plotAddShape or plotAddTextbox. Here is an example
adding three text boxes to a graph at once:

//Create x and y coordinates
x = { 67, 80, 46 };
y=1{2.9, 3.6, 1.4 };

//Create scatter plot
plotScatter(x, vy);

//Create string array of text labels
countries = "France" $| "Germany" $| "Spain";

//Add labels to scatter points
plotAddTextbox (countries, x, vy);
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6.9.3 Customization with a plotAnnotation structure

After an annotation has been added to a graph, you can customize it with the Graphics
Editor. If you would to set the style for your annotation inside of your GAUSS program,
you can do this with a plotAnnotation structure. The steps for using a plotAnnotation
structure are:

1. Declare an instance of a plotAnnotation structure
2. Fill in the plotAnnotation with default values

3. Set your desired options

4. Pass the structure in as the first argument to one of the annotation add functions

If you would like to create an instance of a plotAnnotation structure called myAn-
notation and fill it in with default values, steps 1 and 2 above, you would do this:

//Declare ‘myAnnotation’ to be an instance
//of a ‘plotAnnotation’ structure
struct plotAnnotation myAnnotation;

//Fill ‘myAnnotation’ with default values
myAnnotation = annotationGetDefaults () ;

Now you are ready to apply your desired style preferences to ‘myAnnotation’ with the
‘annotationSet” functions. Available functions include:

annotationSetBkd Sets the color and transparency level of the
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annotation’s background

annotationSetFont Sets the font style, font size and font color for a
text box

annotationSetLineColor Sets the line color for an arrow or the border of
a shape

annotationSetLineStyle Sets the line style for an arrow or the border of a
shape

annotationSetLine Thickness Sets the line thickness for an arrow or the border
of a shape

You do not need to memorize this list or consult it when you are writing a program. Sim-
ply start typing “annotationSet” into the GAUSS editor and the autocomplete will
provide the full list of available functions.

6.9.4 Using the annotationSet functions

The ‘annotationSet’ functions work in the same manner as the ‘plotSet’ functions. The
first argument will be a pointer to a ‘plotAnnotation’ structure (which simply means that
there is an ampersand (&) in front of the name). The remaining arguments to the func-
tion will be the settings to apply.

Example: Styling an ellipse

Let’s say that we would like to highlight a section of the center of our graph. We can do
this by adding a semi-transparent circle to the center of the graph.

//Declare instance of ‘plotAnnotation’ structure
struct plotAnnotation myEllipse;

//Fill in ‘myEllipse’ with default values
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myEllipse = annotationGetDefaults() ;

//Set the ellipse color to be violet
//and make it 30% opaque
annotationSetBkd (&émyEllipse, "violet", 0.3);

//Add ellipse to the center of the graph
x start = 2;

y start
x end = 3;

y_end = 8;

plotAddsShape (myEllipse, "ellipse", x start, y start, x end,
y end) ;

Il
(@)
~

To see examples of styling text boxes or arrows see the documentation for plotAd-
dTextbox and plotAddArrow.
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GAUSS allows you to interactively change most all attributes of a created graph. First
create a graph. For demonstration purposes you may run the example program ran-
domwalk.e to create a graph. Next open the Graph Settings window if it is not open
already, by selecting View->Graph Settings from the menu bar.

7 Graphics Editing
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Figure 7.1: Open the Graph Settings Window
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7.1 Changing Appearance

Click on the graph or a graph annotation object to view its settings in the Graph Settings
Window. When an item is selected its outer border will be highlighted with a red, dash
line. Interacting with the Graph Settings is simple. Single-click on color squares to open
a color settings dialog. Single-click on drop-down menus to view the available options.
Double-click on font names to open your systems font dialog and also double-click on
text inputs, such as the "X-Axis" label, to enter new text.

Figure 7.2: Color Palette
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For example, click on the red color square next to "Line Color" under "Curve 1" to open

the Color Palette dialog as shown above. Double-click the current text next to "Caption'

under "Title" to enter text for the graph title as shown below.
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Figure 7.3: Text Options
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Double-click font names in the graph settings window to open a font dialog window.
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7.2 Adding Items
The Graphics Page toolbar has buttons for adding

o Lines and arrows
o Rectangles

o Ellipses

o Text boxes

To add an item, click the appropriate toolbar button and then click and drag to create the

object in your graphic window.

File Edit Tools View Help
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‘ : |
=

| Field Value

Figure 7.5: Select the item to add

0.0358, 4.0304

o
0%0

>
“ Oﬁo
- 00
[

Figure 7.6: Click and drag to add the object
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7.3 Adding Text to a Text Box

First add the textbox to the graph by selecting the textbox icon, which looks like a capital
T, from the main GAUSS menubar. Then click and drag to size the textbox inside of

your graph.

I

< GAUSS
File Edit Tools View Help

= 0 B8 @ — .

:‘-'Ln vu uD:nTl:} @v"ﬁvl”=_-f’l

| T Graph Settings [ Add Text b X | Random walk [£]
Figure 7.7: Color Palette

When you finish sizing the textbox, the Graphics Settings Window will open, displaying
the graphical controls that allow you to customize the textbox. Towards the bottom of the
graphics Settings Window will be the Content Input Pane. Its header will read "Content
(Text/HTML). Enter the text that you would like to appear inside the textbox in the Con-
tent Input Pane and click the "Apply" button. You may enter text which can include snip-
pets of HTML to create subscripting, superscripting, Greek letters or other special
characters and formatting.
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Figure 7.8: Entering content for a textbox

7.4 Which Object Will Be Edited?

If a graph or graphics object is actively selected, its border will be highlighted red.
Changes made in the Graph Settings Window will apply to this selected object. If no
object is actively selected, the Graph Settings Window will display the settings for the
Canvas. The Canvas is the entire scene in which the graph or graphs are placed.
Changing the Canvas properties is used to make final changes to the sizing of a graph

before exporting.
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Figure 7.9: Highlighted Object

7.5 Moving and Resizing Objects

To move an object, including graphs, legends, textboxes and other annotations, hover
your mouse over it. When your mouse pointer is a hand icon and the object you would
like to move has a blue highlight around its edges, click and drag to move the object to
its desired location.
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AN

Figure 7.10: Moving a graphic object

Hover over the corner of an object until your mouse pointer is two opposing arrows and
the object has a blue edge highlight. Then click and drag to resize the object.

Figure 7.11: Resizing a graphic object
7.5.1 Note on Programmatic Annotations

Annotations that are added programmatically are tied to the coordinates to which they
are placed. Items that are placed on the graph by two graph coordinate points such as
arrow cannot be manually relocated. Items that are placed on the graph by only one
coordinate point, such as textboxes, may be manually pivoted around the fixed point.




8 Using the Command Line Interface

TGAUSS is the command line version of GAUSS. The executable file, tgauss, is loc-
ated in the GAUSS installation directory.

The format for using TGAUSS is:

tgauss flag(s) program program. . .

-1 logfile

-e expression

Execute file in batch mode and then exit. You can
execute multiple files by separating file names with
spaces.

Set the name of the batch mode log file when using
the —b argument. The default is tmp/gauss.log###,
where ### is the process ID.

Execute a GAUSS expression. This command is not
logged when GAUSS is in batch mode.

Suppress the sign-on banner (output only).

Turn the dataloop translator on.
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-t Turn the dataloop translator off.

8.1 Viewing Graphics

NOTE: Graphics using plot* functions are only available from the graphical user inter-
face.

The deprecated Publication Quality Graphics graphics generated . tkf files for graph-
ical output. The default output for these graphics is graphic.tkf. On Windows, you
canuse vwr .exe to view the graphics file; on Linux/Mac, you can use vwrmp. Two
functions are available to convert . tkf files to PostScript for printing and viewing with
external viewers: the tk£2ps function will convert . tkf files to PostScript (.ps)
files, and the tkf2eps function will convert . tkf files to encapsulated PostScript
(.eps) files. For example, to convert the file graphic. tkf to a postscript file named
graphic.ps use:

ret = tkf2ps("filename.tkf", "filename.ps")

If the function is successful it returns 0.

8.2 Command Line History and Command Line Editing

When you run a command at the TGAUSS prompt, it is added to your command line his-
tory, which is stored in a file called .gauss_prompt_history in your §(HOME) directory
on Linux or in your S(HOMEDRIVE)\$(HOMEPATH) directory on Windows. A sep-
arate history for commands entered in the command line debugger is stored in a file
called .gauss_debug prompt history in the same directory. By default, the last 500 com-
mands executed at the TGAUSS and debugger command lines are stored in these files.
You can change this number by changing prompt hist num in your gauss . cfqg file.
The following keystrokes are supported for movement and editing at the command line
and for retrieving the command line history:
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8.2.1 Movement

HOME or CTRL+A

END or CTRL+E

8.2.2 Editing

DELETE or CTRL+D

BACKSPACE or
CTRL+H

CTRL+U
CTRL+K
CTRL+X
ESC (Win only)
CTRL+V

CTRL+T

Moves cursor to beginning of line

Moves cursor to end of line

Deletes character at cursor

Deletes character left of cursor

Cuts all characters left of cursor

Cuts all characters right of cursor, including cursor
Cuts whole line

Deletes whole line

Pastes text from buffer to left of cursor

Transposes character at cursor and character left of
cursor

8.2.3 History Retrieval

Up Arrow Or
CTRL+P

Down Arrow Or
CTRL+P

Retrieves previous line in history

Retrieves next line in history

8-3
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PAGE UP or CTRL+W

PAGE DOWN or
CTRL+S

ALT+H or OPTION+H
(MAC only)

! num

!'— num

! text

ALT+/ or ALT+? or

Retrieves previous line in history that matches text to
left of cursor

Retrieves next line in history that matches text to left
of cursor

Prints prompt history to screen

Runs last line in history

Runs the num line in history

Runs the line num before current line in history;
I-1 is equivalent to !!

Runs last line in history beginning with text

Prints help screen

OPTION+/ (MAC
only)

Note that some of these keystrokes are mapped differently on different computers. For
example, on some computers, SHIFT+RIGHT ARROW behaves the same as RIGHT
ARROW, while ALT+RIGHT ARROW moves the cursor right one word. Therefore, mul-
tiple keystroke mappings have been supported to maximize the availability of these com-
mandson any given machine.

8.3 Interactive Commands

This section discusses interactive commands available in TGAUSS.
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8.3.1 quit
The quit command will exit TGAUSS.
The format for quit is:

quit

You can also use the system command to exit TGAUSS from either the command line
or a program (see system in the GAUSS LANGUAGE REFERENCE).

The format for system is:

system

8.3.2 ed

The ed command will open an input file in an external text editor (see ed in the
GAUSS LANGUAGE REFERENCE).

The format for ed is:

ed filename

8.3.3 browse

The browse command allows you to search for specific symbols in a file and open the
file in the default editor. You can use wildcards to extend search capabilities of the
browse command.

The format for browse is:

browse
symbol

8-5
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8.3.4 config

The config command gives you access to the configuration menu allowing you to
change the way GAUSS runs and compiles files.

The format for config is:

config
Run Menu
Translator Toggles on/off the translation of a file using
dataloop. The translator is not necessary for
GAUSS program files not using dataloop.
Translator line Toggles on/off execution time line number tracking
number tracking of the original file before translation.
Line number Toggles on/off the execution time line number
tracking tracking. If the translator is on, the line numbers refer
to the translated file.
Compile Menu
Autoload Toggles on/off the autoloader.
Autodelete Toggles on/off autodelete.
GAUSS Library Toggles on/off the GAUSS library functions.
User Library Toggles on/off the user library functions.
Declare Warnings Toggles on/off the declare warning messages during
compiling.
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Compiler Trace Includes the following options:
Off Turns off the compiler trace
function.
File Traces program file openings and
closings.
Line Traces compilation by line.
Symbol Creates a report of procedures and the local and

global symbols they reference.

8.4 Debugging
The debug command runs a program under the source level debugger.

The format for debug is:

debug filename

8.4.1 General Functions

? Displays a list of available commands.

q/Esc Exits the debugger and returns to the GAUSS
command line.

+/- Disables the last command repeat function.
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8.4.2 Listing Functions

1l number

lc

ll file line

11 file

11l Iline

11

1p

Displays a specified number of lines of source code
in the current file.

Displays source code in the current file starting with
the current line.

Displays source code in the named file starting with
the specified line.

Displays source code in the named file starting with
the first line.

Displays source code starting with the specified line.
File does not change.

Displays the next page of source code.

Displays the previous page of source code.

8.4.3 Execution Functions

S number

n number

X number

Executes the specified number of lines, stepping into
procedures.

Executes the specified number of lines, stepping over
procedures.

Executes code from the beginning of the program to
the specified line count, or until a breakpoint is hit.

Executes from the current line to the end of the
program, stopping at breakpoints. The optional
arguments specify other stopping points. The syntax

8-8



Using the Command
Line Interface

for each optional argument is:

filename
line
period

filename
line

filename
,, period

line
period

filename

line

procedure
period

procedure

The debugger will stop every
period times it reaches the
specified Iine in the named
file.

The debugger will stop when it
reaches the specified 1ine
in the named file.

The debugger will stop every
period times it reaches any
line in the named file.

The debugger will stop every
period times it reaches the
specified Iine inthe
current file.

The debugger will stop at every
line in the named file.

The debugger will stop when it
reaches the specified 1ine
in the current file.

The debugger will stop every
period times it reaches the
first line in a called procedure.

The debugger will stop every
time it reaches the first line in a
called procedure.
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jx number

Executes code to a specified line, procedure, or
period in the file without stopping at breakpoints. The
optional arguments are the same as g, listed above.

Executes code to the execution count specified
(numbe r) without stopping at breakpoints.

Executes the remainder of the current procedure (or
to a breakpoint) and stops at the next line in the
calling procedure.

8.4.4 View Commands

v [[vars]]

v$[[vars]]

Searches for (a local variable, then a global variable)
and displays the value of a specified variable.

Searches for (a local variable, then a global variable)
and displays the specified character matrix.

The display properties of matrices and string arrays can be set using the following com-

mands.

Specifies the number of rows to be shown.
Specifies the number of columns to be shown.

Specifies the indices of the upper left corner of the
block to be shown.

Specifies the width of the columns to be shown.

Specifies the precision shown.
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8.4.5 Breakpoint Commands

1b
b

Specifies the format of the numbers as decimal,
scientific, or auto format.

Quits the matrix viewer.

Shows all the breakpoints currently defined.

Sets a breakpoint in the code. The syntax for each optional

argument is:
filename line
period

filename line

filename ,,
period

line period

filename

line

The debugger will stop every
period times it reaches the specified
11ine in the named file.

The debugger will stop when it reaches
the specified 1ine in the named file.

The debugger will stop every
period times it reaches any line in
the named file.

The debugger will stop every
period times it reaches the specified
11ine in the current file.

The debugger will stop at every line in
the named file.

The debugger will stop when it reaches
the specified line in the current file.
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procedure The debugger will stop every
period period times it reaches the first line
in a called procedure.

procedure The debugger will stop every time it
reaches the first line in a called
procedure.
d Removes a previously specified breakpoint. The optional

arguments are the same arguments as b, listed above.

8.5 Using the Source Browser in TGAUSS

To start the Source Browser in TGAUSS, type BROWSE followed by a symbol name.
When the Source Browser is active, the prompt displays Browse : . GAUSS searches
through all active libraries for the file in which the symbol is defined. If found, the file
containing the source code is opened in the default editor.

Wildcard (*) searches can also be used. When using wildcard searches, each symbol
that the string matches will be displayed on-screen in a numbered list. To select a spe-
cific command to view in the default editor, select the number from the list.

The Source Browser will remain active until you type CTRL+C to return to the GAUSS
prompt.
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9 Language Fundamentals

GAUSS is a compiled language. GAUSS is also an interpreter. A compiled language,
because GAUSS scans the entire program once and translates it into a binary code
before it starts to execute the program. An interpreter, because the binary code is not the
native code of the CPU. When GAUSS executes the binary pseudocode it must "inter-
pret" each instruction for the computer.

How can GAUSS be so fast if it is an interpreter? Two reasons. First, GAUSS has a
fast interpreter, and the binary compiled code is compact and efficient. Second, and
most significantly, GAUSS is a matrix language. It is designed to tackle problems that
can be solved in terms of matrix or vector equations. Much of the time lost in inter-
preting the pseudocode is made up in the matrix or vector operations.

This chapter will enable you to understand the distinction between "compile time" and
"execution time," two very different stages in the life of a GAUSS program.

9.1 Expressions

An expression is a matrix, string, constant, function reference, procedure reference, or
any combination of these joined by operators. An expression returns a result that can be
assigned to a variable with the assignment operator '='.

9-1
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9.2 Statements

A statement is a complete expression or command. Statements end with a semicolon.
y = x*3;

If an expression has no assignment operator (=), it will be assumed to be an implicit
print statement:
print x*3;
or
=538
Here is an example of a statement that is a command rather than an expression:

output on;

Commands cannot be used as a part of an expression.

There can be multiple statements on the same line as long as each statement is ter-
minated with a semicolon.

9.2.1 Executable Statements

Executable statements are statements that can be "executed" over and over during the
execution phase of a GAUSS program (execution time). As an executable statement is
compiled, binary code is added to the program being compiled at the current location of
the instruction pointer. This binary code will be executed whenever the interpreter
passes through this section of the program. If this code is in a loop, it will be executed
each iteration of the loop.

Here are some examples of executable statements:

9-2



Language
Fundamentals

y = 34.25;
print y;

x=13729 403 ;

9.2.2 Nonexecutable Statements

Nonexecutable statements are statements that have an effect only when the program is
compiled (compile time). They generate no executable code at the current location of the

instruction pointer.

Here are two examples:

declare matrix x = 1 2 3 4 ;

external matrix ybar;

Procedure definitions are nonexecutable. They do not generate executable code at the
current location of the instruction pointer.

Here is an example:

zed = rndn (3, 3) ;

proc sqgrtinv (x) ;
local vy;
y = sqrt(x);
retp (y+inv (x)) ;
endp;

zsl = sqgrtinv(zed);

There are two executable statements in the example above: the first line and the last
line. In the binary code that is generated, the last line will follow immediately after the
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first line. The last line is the call to the procedure. This generates executable code.
The procedure definition generates no code at the current location of the instruction
pointer.

There is code generated in the procedure definition, but it is isolated from the rest of the
program. It is executable only within the scope of the procedure and can be reached only
by calling the procedure.

9.3 Programs

A program is any set of statements that are run together at one time. There are two sec-
tions within a program.

9.3.1 Main Section

The main section of the program is all of the code that is compiled together WITHOUT
relying on the autoloader. This means code that is in the main file or is included in the
compilation of the main file with an #include statement. ALL executable code should
be in the main section.

There must always be a main section even if it consists only of a call to the one and only
procedure called in the program.

9.3.2 Secondary Sections

Secondary sections of the program are files that are neither run directly nor included in
the main section with #include statements.

The secondary sections of the program can be left to the autoloader to locate and com-
pile when they are needed. Secondary sections must have only procedure definitions and
other nonexecutable statements.

#include statements are allowed in secondary sections as long as the file being
included does not violate the above criteria.
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Here is an example of a secondary section:

declare matrix tol = 1.0e-15;
proc feq(a,b);

retp (abs (a-b) <= tol);
endp;

9.4 Compiler Directives

Compiler directives are commands that tell GAUSS how to process a program during
compilation. Directives determine what the final compiled form of a program will be.
They can affect part or all of the source code for a program. Directives are not execut-
able statements and have no effect at run-time. They do not take a semicolon at the end
of the line.

The #include statement mentioned earlier is actually a compiler directive. It tells
GAUSS to compile code from a separate file as though it were actually part of the file
being compiled. This code is compiled in at the position of the # include statement.

Here are the compiler directives available in GAUSS:

#define Define a case-insensitive text-replacement or flag
variable.

tdefinecs Define a case-sensitive text-replacement or flag
variable.

#undef Undefine a text-replacement or flag variable.

#ifdef Compile code block if a variable has been
#define'd.

#ifndef Compile code block if a variable has not been
#define'd.

#iflight Compile code block if running GAUSS Light.

9-5
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#ifunix

#else

#endif

#include

#lineson

#linesoff

#srcfile

#srcline

Compile code block if running UNIX.

Else clause for #1f-#else-#endif code block.
Endof #if-#else-#endif code block.
Include code from another file in program.

Compile program with line number and file name
records.

Compile program without line number and file name
records.

Insert source file name record at this point (currently
used when doing data loop translation).

Insert source file line number record at this point
(currently used when doing data loop translation).

The #define statement can be used to define abstract constants. For example, you
could define the default graphics page size as:

#define hpage 9.0

#define vpage 6.855

and then write your program using hpage and vpage. GAUSS will replace them with
9.0 and 6.855 when it compiles the program. This makes a program much more readable.

The #1ifdef-#else-#endif directives allow you to conditionally compile sections of
a program, depending on whether a particular flag variable has been #define'd. For

example:

#ifdef log 10
y = log(x);

#else
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y = 1In(x);
#endif

This allows the same program to calculate answers using different base logarithms,
depending on whether or not the program has a #define log 10 statement at the
top.

#undef allows you to undefine text-replacement or flag variables so they no longer
affect a program, or so you can #define them again with a different value for a dif-
ferent section of the program. If you use #definecs to define a case-sensitive vari-
able, you must use the right case when #unde f'ing it.

With #1ineson, #1inesoff, #srcline, and #srcfile you can include line
number and file name records in your compiled code, so that run-time errors will be
easier to track down. #srcline and #srcfile are currently used by GAUSS
when doing data loop translation.

For more information on line number tracking, see Debugging, Section 8.4 and see
Debugging Data Loops, Section 25.3 . See also #1ineson in the GAUSS LANGUAGE
REFERENCE.

The syntax for #srcfile and #srcline is different than for the other directives that
take arguments. Typically, directives do not take arguments in parentheses; that is, they
look like keywords:

#define red 4

#srcfile and #srcline, however, do take their arguments in parentheses (like pro-
cedures):

#srcline (12)

This allows you to place #srcline statements in the middle of GAUSS commands,
so that line numbers are reported precisely as you want them. For example:

#srcline(l) print "Here is a multi-line "
#srcline (2) "sentence--if it contains a run-time error,

"w
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#srcline (3) "you will know exactly "
#srcline (4) "which part of the sentence has the problem.";

The argument supplied to #srcfile does not need quotes:

#srcfile(/gauss/test.e)

9.5 Procedures

A procedure allows you to define a new function which you can then use as if it were an
intrinsic function. It is called in the same way as an intrinsic function.

y = myproc(a,b,c);

Procedures are isolated from the rest of your program and cannot be entered except by
calling them. Some or all of the variables inside a procedure can be 1ocal variables.
local variables exist only when the procedure is actually executing and then dis-
appear. Local variables cannot get mixed up with other variables of the same name in
your main program or in other procedures.

For details on defining and calling procedures, see PROCEDURES AND KEYWORDS,
CHAPTER 11 .

9.6 Data Types

There are four basic data types in GAUSS, matrices, N-dimensional arrays, strings and
string arrays. It is not necessary to declare the type of a variable, but it is good pro-
gramming practice to respect the types of variables whenever possible. The data type
and size can change in the course of a program.

The declare statement, used for compile-time initialization, enforces type checking.

Short strings of up to 8 bytes can be entered into elements of matrices, to form character
matrices (For details, see Command Summary, Section 28.1 ).
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9.6.1 Constants

The following constant types are supported:

Decimal

Decimal constants can be either integer or floating point values:

1.34e-10
1.34el23
-1.34e+10
-1.34d-10
1.34d10
1.34d+10
123.456789345

Up to 18 consecutive digits before and after the decimal point(depending on the plat-
form) are significant, but the final result will be rounded to double precision if neces-
sary. The range is the same as for matrices (For details, see Matrices, Section 9.6.2

String
String constants are enclosed in quotation marks:

"This is a string."

Hexadecimal Integer

Hexadecimal integer constants are prefixed with 0x:

0x0ab53def?2

Hexadecimal Floating Point

Hexadecimal floating point constants are prefixed with Ov. This allows you to input a
double precision value exactly as you want using 16 hexadecimal digits. The highest
order byte is to the left:

9-9
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OvE££8000000000000

9.6.2 Matrices

Matrices are 2-dimensional arrays of double precision numbers. All matrices are impli-
citly complex, although if it consists only of zeros, the imaginary part may take up no
space. Matrices are stored in row major order. A 2x3 real matrix will be stored in the fol-
lowing way from the lowest addressed element to the highest addressed element:

(1,11 [i,21 [1,31 [2,1] [2,2] [2,3]

A 2x3 complex matrix will be stored in the following way from the lowest addressed ele-
ment to the highest addressed element:

(real part) (1,1] [1,2] [1,3] [2,1] [2,2] [2,3]
(imaginary part) [1,1] [1,2] [1,3] [2,1] [2,2] [2,3]

Conversion between complex and real matrices occurs automatically and is transparent
to the user in most cases. Functions are provided to provide explicit control when neces-
sary.

All elements of a GAUSS matrix are stored in double precision floating point format,
and each takes up 8 bytes of memory. This is the IEEE 754 format:

Bytes Data Type Significant Digits Range
8 floating point 15-16 4.19 x 10307
<=|X|<=1.67 x

Matrices with only one element (1x1 matrices) are referred to as scalars, and matrices
with only one row or column (1xN or Nx1 matrices) are referred to as vectors.

Any matrix or vector can be indexed with two indices. Vectors can be indexed with one
index. Scalars can be indexed with one or two indices also, because scalars, vectors,
and matrices are the same data type to GAUSS.
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The majority of functions and operators in GAUSS take matrices as arguments. The fol-
lowing functions and operators are used for defining, saving, and loading matrices:

L1

con

cons

declare

let

load

readr

save

saved

stof

submat

writer

Indexing matrices.

Assignment operator.

Vertical concatenation.

Horizontal concatenation.

Numeric input from keyboard.

Character input from keyboard.
Compile-time matrix or string initialization.
Matrix definition statement.

Load matrix (same as 1loadm).

Read from a GAUSS matrix or data set file.
Save matrices, procedures and strings to disk.
Convert a matrix to a GAUSS data set.
Convert string to matrix.

Extract a submatrix.

Write data to a GAUSS data set.

Following are some examples of matrix definition statements.

An assignment statement followed by data enclosed in braces is an implicit 1et state-
ment. Only constants are allowed in 1et statements; operators are illegal. When braces
are used in let statements, commas are used to separate rows. The statement

let x

6, 78 9 ;

9-11

s|ejuswepun 4

abenbue



GAUSS User Guide

)

T

will result in

will result in

will result in

The statement

will result in

-12

=]



Language
Fundamentals

000
x =000
000

The statement

let x =1 2 3456 7 8 9;

will result in

X
Il
© © o U WN

Complex constants can be entered in a 1et statement. In the following example, the +
or - is not a mathematical operator, but connects the two parts of a complex number.
There should be no spaces between the + or - and the parts of the number. If a number
has both real and imaginary parts, the trailing 'i' is not necessary. If a number has no real
part, you can indicate that it is imaginary by appending the 'i'. The statement

let x[2,2] = 1+21 3-4 5 61i;

will result in

x = 1+2i 3-41i
5 0+61

Complex constants can also be used with the declare, con and stof statements.

An "empty matrix" is a matrix that contains no data. Empty matrices are created with
the let statement and braces:
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x = {};

Empty matrices are supported by several functions, including rows and cols and the
concatenation (~, |) operators.

x = {};

hsecO = hsec;

do until hsec-hsecO0 > 6000;

x = X ~ data_in(hsec-hsec0);
endo;

You can test whether a matrix is empty by entering rows(x), cols(x) and scalerr
(x). If the matrix is empty rows and cols will return a 0, and scalerr will return
65535.

The ~ is the horizontal concatenation operator and the | is the vertical concatenation
operator. The statement

y = 1~2|3~4;
will be evaluated as

y = (1~2)1(3~4);

and will result in a 2x2 matrix because horizontal concatenation has precedence over ver-
tical concatenation:

y =12
3 4
The statement

y = 141~2*2|3-2~6/2;

will be evaluated as

y = ((1+1) ~ (2*2)) | ((3-2) ~ (6/2));
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and will result in a 2x2 matrix because the arithmetic operators have precedence over
concatenation:

y = 2 4
13
For more information, see Operator Precedence, Section 10.7 .
The 1et command is used to initialize matrices with constant values:
let x[2,2] =1 2 3 4;

Unlike the concatenation operators, it cannot be used to define matrices in terms of
expressions such as:

y = x1-x2~x2|x3*3~x4;

The statement

y = x[1:3,5:8];

will put the intersection of the first three rows and the fifth through eighth columns of x
into the matrix y.

The statement

y = x[1 31,55 9];

will create a 3x3 matrix y with the intersection of the specified rows and columns pulled
from x (in the indicated order).

The following code

let r =1 3 1;
let ¢ =55 9;
y = x[r,cl;

will have the same effect as the previous example, but is more general.
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The statement

yl2,4] = 3;

will set the 2,4 element of the existing matrix y to 3. This statement is illegal if y does
not have at least 2 rows and 4 columns.

The statement
x = con(3,2);
will cause the following prompt to be printed in the window:

- (1,1)

indicating that the user should enter the [1,1] element of the matrix. Entering a number
and then pressing ENTER will cause a prompt for the next element of the matrix to
appear. Pressing ? will display a help screen, and pressing x will exit.

The statement

load x[] = b:mydata.asc

will load data contained in an ASCII file into an Nx1 vector x. (Use rows (x) to find
out how many numbers were loaded, and use reshape (x, N, K) toreshape it to an
NxK matrix).

The statement

load x;

will load the matrix x . fmt from disk (using the current load path) into the matrix x in
memory.

The statement

open dl = datl;
x = readr (d1,100);
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will read the first 100 rows of the GAUSS data set datl.dat.

9.6.3 Sparse Matrices

Many GAUSS operators and commands support the sparse matrix data type. You may
use any of the following commands to create a sparse matrix:

denseToSp

denseToSpRE

packedToSp

spCreate

spEye

spOnes

spZeros

Converts a dense matrix to a sparse matrix.

Converts a dense matrix to a sparse matrix, using a
relative epsilon.

Creates a sparse matrix from a packed matrix of non-
zero values and row and column indices.

Creates a sparse matrix from vectors of non-zero
values, row indices, and column indices.

Creates a sparse identity matrix.

Generates a sparse matrix containing only ones and
zZeros

Creates a sparse matrix containing no non-zero
values.

See SPARSE MATRICES, CHAPTER 13, for more information.

9.6.4 N-dimensional Arrays

Many GAUSS commands support arrays of N dimensions. The following commands
may be used to create and manipulate an N-dimensional array:

aconcat

Concatenate conformable matrices and arrays in a
user-specified dimension.
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aeye

areshape

arrayalloc

arrayinit

mattoarray

Create an N-dimensional array in which the planes
described by the two trailing dimensions of the array
are equal to the identity.

Reshape a scalar, matrix, or array into an array of
user-specified size.

Create an N-dimensional array with unspecified
contents.

Create an N-dimensional array with a specified fill
value.

Convert a matrix to a type array.

See N-DIMENSIONAL ARRAYS, CHAPTER 14 , for a more detailed explanation.

9.6.5 Strings

Strings can be used to store the names of files to be opened, messages to be printed,
entire files, or whatever else you might need. Any byte value is legal in a string from 0-
255. The buffer where a string is stored always contains a terminating byte of ASCII 0.
This allows passing strings as arguments to C functions through the Foreign Language

Interface.

Here is a partial list of the functions for manipulating strings:

S+

~

chrs

dttostr

Combine two strings into one long string.
Interpret following name as a variable, not a literal.
Convert vector of ASCII codes to character string.

Convert a matrix containing dates in DT scalar
format to a string array.
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ftocv

ftos

ftostrC

getf

indcv

lower

stof

strindx

strlen

strsect

strsplit

strsplitPad

strtodt

strtof

strtofcplx

upper

Character representation of numbers in NxK
matrix.

Character representation of numbers in 1x1 matrix.

Convert a matrix to a string array using a C
language format specification.

Load ASCII or binary file into string.

Find index of element in character vector.
Convert to lowercase.

Convert string to floating point.

Find index of a string within a second string.
Length of a string.

Extract substring of string.

Split an Nx1 string vector into an NxK string array
of the individual tokens.

Split a string vector into a string array of the
individual tokens. Pads on the right with null
strings.

Convert a string array of dates to a matrix in DT
scalar format.

Convert a string array to a numeric matrix.

Convert a string array to a complex numeric
matrix.

Convert to uppercase.
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vals Convert from string to numeric vector of ASCII
codes.

Strings can be created like this:

X "example string";

or

i
|

= cons; // keyboard input
or
x = getf ("myfile",0); // read a file into a string
They can be printed like this:
print x;
A character matrix must have a '$' prefixed to it in a print statement:
print $x;

A string can be saved to disk with the save command in a file with a . £st extension
and then loaded with the 1oad command:

save X;
loads x;

or
loads x=x.fst;

The backslash is used as the escape character inside double quotes to enter special
characters:
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"\b" backspace (ASCII 8)
"\e" escape (ASCII 27)
"\ formfeed (ASCII 12)
"\g" beep (ASCII 7)
AR line feed (ASCII 10)
"\ carriage return (ASCII 13)
g tab (ASCII 9)
A a backslash
T\#EET the ASCII character whose decimal value is "###".

When entering DOS pathnames in double quotes, two backslashes must be used to insert
one backslash:

st = "c:\\gauss\\myprog.prg";

An important use of strings and character elements of matrices is with the substitution
operator (). In the command

create fl1 = olsdat with x,4,2;

by default, GAUSS will interpret the oIsdat as a literal; that is, the literal name of the
GAUSS data file you want to create. It will also interpret the x as the literal prefix
string for the variable names: x1 x2 x3 x4.If you want to get the data set name
from a string variable, the substitution operator () could be used as:

dataset="olsdat";
create fl="dataset with x,4,2;
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If you want to get the data set name from a string variable and the variable names from
a character vector, use

dataset="olsdat";
let vnames=age pay sex;
create fl="dataset with “vnames,0,2;

The substitution operator () works with 1oad and save also:

lpath="/gauss/procs";
name="mydata";

load path="1lpath x="name;
command="dir *.fmt";

The general syntax is:

“variable name

Expressions are not allowed. The following commands are supported with the sub-
stitution operator (*):

create fl="dataset with “vnames,0,2;
create fl="dataset using “cmdfile;
open fl="dataset;

output file="outfile;

load x="datafile;

load path="1lpath x,y,z,t,w;
loadexe buf="exefile;

save “name=x;

save path="spath;

dos “cmdstr;

run “prog;

msym “mstring;
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9.6.6 String Arrays

String arrays are NxK matrices of strings. Here is a partial list of the functions for

manipulating string arrays:

Sl

declare

delete

fgetsa

fgetsat

format

fputs

fputst

let

loads

lprint

Vertical string array concatenation operator.
Horizontal string array concatenation operator.

Extract subarrays or individual strings from their
corresponding array, or assign their values.

Transpose operator.
Bookkeeping transpose operator.

Initialize variables at compile time.

s|ejuswepun 4

Delete specified global symbols.
Read multiple lines of text from a file.

Reads multiple lines of text from a file, discarding
newlines.

Define output format for matrices, string arrays, and
strings.

Write strings to a file.

Write strings to a file, appending newlines.
Initialize matrices, strings, and string arrays.
Load a string or string array file ( . £st file).

Print expressions to the printer.
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lshow

print

reshape

save

show

sortcc

type

typecv

varget

varput

vec

vecr

Print global symbol table to the printer.
Print expressions on window and/or auxiliary output.
Reshape a matrix or string array to new dimensions.

Save matrix, string array, string, procedure, function
or keyword to disk and gives the disk file either a
.fmt, . fst or . fcg extension.

Display global symbol table.

Quick-sort rows of matrix or string array based on
character column.

Indicate whether variable passed as argument is
matrix, string, or string array.

Indicate whether variables named in argument are
strings, string arrays, matrices, procedures, functions
or keywords.

Access the global variable named by a string array.
Assign the global variable named by a string array.

Stack columns of a matrix or string array to form a
column vector.

Stack rows of a matrix or string array to form a
column vector.

String arrays are created through the use of the string array concatenation operators.
Below is a contrast of the horizontal string and horizontal string array concatenation

operators. The statements:
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— nagen;
— "pay"’.

— "SeX";

= xS$+yS$+n;
sa = xS$~y$~n;

n 85K X

assign the values:

S = agepaysex
s = age pay sex

9.6.7 Character Matrices

Matrices can have either numeric or character elements. For convenience, a matrix con-
taining character elements is referred to as a character matrix.

A character matrix is not a separate data type, but gives you the ability to store and
manipulate data elements that are composed of ASCII characters as well as floating
point numbers. For example, you may want to concatenate a column vector containing
the names of the variables in an analysis onto a matrix containing the coefficients, stand-
ard errors, t-statistic, and p-value. You can then print out the entire matrix with a sep-
arate format for each column with one call to the function print£m.

The logic of the programs will dictate the type of data assigned to a matrix, and the
increased flexibility allowed by being able to bundle both types of data together in a
single matrix can be very powerful. You could, for instance, create a moment matrix
from your data, concatenate a new row onto it containing the names of the variables and
save it to disk with the save command.

Numeric matrices are double precision, which means that each element is stored in
8 bytes. A character matrix can thus have elements of up to 8 characters.

GAUSS does not automatically keep track of whether a matrix contains character or
numeric information. The ASCII to GAUSS conversion program ATOG will record the
types of variables in a data set when it creates it. The create command will, also. The
function vartypef gets a vector of variable type information from a data set. This
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vector of ones and zeros can be used by print£fm when printing your data. Since
GAUSS does not know whether a matrix has character or numeric information, it is up
to you to specify which type of data it contains when printing the contents of the matrix.
(For details, see print and print£fm in the GAUSS LANGUAGE REFERENCE.)

Most functions that take a string argument will take an element of a character matrix
also, interpreting it as a string of up to 8 characters.

9.6.8 Date and Time Formats

DT Scalar Format

The DT scalar format is a double precision representation of the date and time with up
to 14 digits. Each group of digits represents a different aspect of the date and time such
as the year or month. Using characters, to represent each digit in a DT scalar number
would look like this:

YYYYMODDHHSS

Starting from the left: the first four digits represent the year; the fifth and sixth digits, if
present, represent the month; the seventh and eight digits, if present, represent the day;
the ninth and tenth digits represent the hour; the eleventh and twelfth digits, if present,
represent the minutes and finally, the thirteenth and fourteenth digits represent the
seconds.

For example, in DT scalar format, the number:

20120723143207

represents 14:32:07 or 2:32:07 PM on July 23, 2012. It is important to remember that the
leading digits will always be the year. This becomes relevant if the DT scalar number
contains fewer than 14 digits to the right of the decimal point. For example, the number:

201302

would represent February 2013, rather than the time 20:13:02 (or 8:13:02 PM).
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